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This is a basic computer workshop. Microsoft Excel is a spreadsheet program. We use it to 
create reports that need calculations and charts. In this workshop we will learn how to move 
around and work inside the spreadsheet. 

Vocabulary .................................................................................................................................................... 1 
Status Bar Modes .......................................................................................................................................... 1 
Keyboard Navigation ................................................................................................................................. 2 

Ribbon ........................................................................................................................................................... 2 
Clipboard ................................................................................................................................................... 2 
Formatting Cells ........................................................................................................................................ 3 

Cells Structures ............................................................................................................................................. 4 
Inserting .................................................................................................................................................... 4 
Deleting ..................................................................................................................................................... 5 
Cell Size (Row Height/Column Width) ...................................................................................................... 5 

Fill Handle ..................................................................................................................................................... 6 
Building an Equation ..................................................................................................................................... 6 
Type in the exact cell address ................................................................................................................... 6 
Use the mouse to point to the cell address .............................................................................................. 7 
Mathematical Operations ......................................................................................................................... 7 
AutoSum .................................................................................................................................................... 7 

Exercise 1: Customers ................................................................................................................................... 8 
Resizing Columns ...................................................................................................................................... 8 
Freeze Panes (Lock Titles to Top of Page) ................................................................................................. 8 
Format ....................................................................................................................................................... 9 

Exercise 2: Quarter Total ............................................................................................................................ 10 
Fill Handle ................................................................................................................................................ 10 
Format ..................................................................................................................................................... 10 
Chart ........................................................................................................................................................ 10 

Exercise 3: Items by Quarter ....................................................................................................................... 11 
Insert Rows .............................................................................................................................................. 11 
Merged Title ............................................................................................................................................ 11 
Fill Handle Across .................................................................................................................................... 11 
Total Row (AutoSum) .............................................................................................................................. 11 

Exercise 4: Sales Report .............................................................................................................................. 12 
Format ..................................................................................................................................................... 12 
Math ........................................................................................................................................................ 12 
Grand Total ............................................................................................................................................. 12 

 

 

 



 

1 

Vocabulary 

Microsoft Excel is a spreadsheet program. We use it to create reports that need calculations and charts. 

1. An Excel file is called a Workbook.  

- Default title is Book1 

2. Ribbon broken into Tabs (Home, Insert, Page Layout…) 

- Tabs broken into groups (Clipboard, Font, Alignment) 

3. Name box (left) and formula bar (right) 

- Name box shows address of current cell 

- Formula bar shows contents of current cell 

4. Columns Headings are Lettered, Rows Headings are Numbered 

- Columns of a building, rows of chairs 

5. Worksheet navigation buttons, Worksheet tabs 

- Sheet1 

6. Status bar 

- Excel behaves differently depending on the current "mode"  

 

Status Bar Modes 

‐   Ready mode. This means nothing is being entered or edited on the spreadsheet.  

 
‐   Enter mode. This mode is when you are doing data entry, just typing in the contents. 

 
‐   Edit mode. Edit the contents of the current cell. Double‐click on a cell with data in it, or click inside 

the formula bar for this mode. 

 ‐  Point mode. Used when linking to cell addresses within a formula or from an Excel dialog window. 
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Keyboard Navigation  

Key  Ready  Enter  Edit  Point 

Enter  Move Down  Accept changes and move down 

Shift‐Enter  Move Up  Accept changes and move up 

Tab  Move Right  Accept changes and move right 

Shift‐Tab  Move Left  Accept changes and move Left 

 

Arrow Keys  Moves to another cell  Moves between 

characters in cell 

Points to an 

address of a cell 

 

Home  Moves to first column  Moves to the front 

of the line in the cell 

Points to cell in 

column A 

Ctrl‐Home  Moves to the beginning cell of the 

worksheet (A1) 

  Points to the 

beginning of the 

worksheet 

 

Ribbon 

The images of Excel in this packet were copied from a wide screen monitor. With the wide screen the 

ribbon is stretched across the window and I can see all the buttons. If you are working on a narrower 

window, Excel will try to clump the groups together and the layout may look a little different than the 

ones shown here, but all the buttons will be there. 

 

Here we can see how the font group is now three buttons high, and how some of the buttons like Cut 

and Copy have lost their text labels. 

 

Clipboard 

Cut, Copy and Paste are clipboard features built into Windows. The clipboard is a temporary storage 

place for pictures and data. The Windows clipboard can only store one item at a time. Microsoft Office 

has a Multi‐Clipboard that can store 24 items, but the Paste button and the shortcuts for the Paste 

option only correspond to the most recently copied item. The clipboard pane must be displayed to be 

able to use this feature.  

Cut –  Copies selection to the clipboard. If the selection is text or an image, it will 

disappear. If it’s a cell, Excel waits until you paste it to delete the original cell. 

Copy – Copies selection to the clipboard. 

Paste – Retrieves most recent text/object on the clipboard. 
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Formatting Cells 

The most formatting options are found on the Home Tab. All the options can be found in the Format 

Cells window. This contains several tabs to help us format the contents of our spreadsheet. This window 

can be opened by using the   More Options button at the end of the Format, Alignment and Number 

groups. You can also use the Keyboard Shortcut – Ctrl‐1 or choose Format Cells… from the right‐click 

shortcut menu. 

Font 

1. Font – Sets the font of the selected cell(s). Fonts are 
different ways to show the same letters. 

2. Font Size – Sets the size of the letters (the font). Larger 
numbers give larger fonts.  

3. Increase Font – Increases the font size 

4. Decrease Font – Decreases the font size 

5. Bold – Makes the selected cell(s) Bold 

6. Italic – Makes the selected cell(s) Italicized 

7. Underline – Makes the selected cell(s) Underlined. The drop down has a double underline. 

8. Borders – Adds and removes borders for the selected cell(s). The drop down has More Borders…  

9. Fill Color – Changes the background color of the selected cell(s). 

10. Font Color – Changes the color of the font of the selected cell(s).  

11. More Options – This button will open the Format Cells dialog window. 

Alignment 

1. Top Align – Vertically aligns to the top of the cell. 

2. Middle Align – Vertically aligns to middle of the cell. 

3. Bottom Align – Vertically aligns to the bottom of 
the cell.  

4. Orientation – Rotates the contents of the cell to 
the currently displayed option.  

5. Wrap Text – Displays contents on multiple lines within the cell's column width. 

6. Align Text Left – Horizontally aligns the contents to the left side of the column. 

7. Center – Horizontally aligns the contents to the center of the cell.  

8. Align Text Right – Horizontally aligns the contents to the right side of the cell.  

9. Decrease Indent – Decreases the space between the text and the cell border  

10. Increase Indent – Increases the space between the text and the cell border 

11. Merge and Center – Joins selected (adjacent) cells into one cell and centers the result. If there is 
data in more than one cell, Excel will only keep the information from the upper left cell.  

12. More Options – This button will open the Format Cells dialog window to the Alignment Tab.  

  1  2  3  4 

   

  5  6  7  8  9  10  11 

  1  2  3  4  5 
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Number 

1. Number Format – Allows you to change the way numeric values are 
displayed on the spreadsheet. The drop down arrow gives you a list of 
the most common formats, including a More Number Formats option.  

2. Currency Style – Sets the selected cell(s) to the Currency Style, this 
style keeps the dollar signs on the left side of the cell, and the 
number on the right side. The drop down arrow gives you a list of 
other currency formats, such as the Euro (€).  

3. Percent Style – Sets the selected cell(s) to the Percent Style, this style has zero decimal places. 
Keyboard shortcut ‐ Ctrl‐Shift‐%. This button can be reset through Cell Styles on the Home Tab. 

4. Comma Style – Sets the selected cell(s) to the Comma Style, this style has a comma for every 
thousand and two decimal places. This button can be reset through  

5. Increase Decimal – Increases the number of decimal places showing to the right of the decimal.  

6. Decrease Decimal – Decreases the number of decimal places showing to the right of the decimal.  

7. More Options – This button will open the Format Cells dialog window to the Number Tab. 

 

Cells Structures 

There are a set number of cells within a Microsoft Excel worksheet. In the Ribbon versions (2007 and 

later) there are 16,384 columns and 1,048,576 rows. As you insert and delete structures, you are not 

reducing the number of cells, merely shifting where your data lies on the defined worksheet. Think 

about moving a painting around on a wall. You're not changing the wall, just the position of the painting. 

Inserting 

We use Insert to make new cells, columns, and rows.  

Excel determines what you are trying to insert based on your selection. If a full column is selected, Excel 

will assume you mean a full column and it will skip the Insert window.  

You can insert a cell, row, or column by doing one of the 

following: 

 Press Shift ‐ Ctrl ‐ = on the keyboard (ctrl plus) 

 or from the Home tab, in the Cells group, choose Insert 

 or open the Right‐click menu and choose insert.   

 

 ‐   To insert multiple at once, select the number of 

cells/rows/columns you would like to insert and follow the 

steps above.   

 ‐  The size and format of the new space is determined by the previous row or column. 

 ‐  This will push the existing cells, columns, or rows to the right or down to make room for the new cells. 

  1 
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Deleting 

We use Delete to remove cells, columns, and rows.  Excel 

determines what you are trying to delete based on your 

selection. You can delete a cell, row, or column by doing one of 

the following:   

 Press Shift ‐ Ctrl ‐ ‐ on the keyboard (Ctrl Minus) 

 or from the Home tab, in the Cells group, choose Delete 

 or open the Right‐click menu and choose insert.   
 

 ‐  To delete multiple at once, select the number of cells/rows/columns you would like to delete and 

follow the steps above.   

‐   This will completely remove the structure, formatting and all, and the rows/columns/cells will shift 

into this place. If you only intended to delete the contents not the cells, undo and use the Clear 

Contents option instead. 

Cell Size (Row Height/Column Width) 

You cannot resize one cell; the structure is dependent on the entire row and column where it resides. 

The Row Height and Column Width settings can be found under the Format menu in the Cells group of 

the Home tab. 

Adjusting with the Mouse 

When we resize we are growing away from the left.  

To resize the column, place your mouse cursor between the lines of the 

column headings. The current column heading is in a box; all you need to 

do is resize the box to make it wider. Put your mouse along the right side 

of the heading box until you see the resizing arrow pointing in two 

directions. Click and drag away from the column letter. When you let go 

of the mouse, the column will resize. 

 

To resize the row, place your mouse cursor between the lines of the row 

headings. The current row heading is in a box; all you need to do is resize 

the box to make it wider. Put your mouse along the bottom side of the 

heading box until you see the resizing arrow pointing in two directions. 

Click and drag away from the row number. When you let go of the 

mouse, the row will resize. 

Auto‐fitting 

You can use the option found on the Format menu, or place your mouse 

cursor between the headings, with the two‐way arrow to help resize, and 

double‐click. The row or column should AutoFit to the largest data length 

within its structure.  

‐   To resize multiple at once, select the cells you would like to fit and follow the steps above.   

If you are using double‐click to auto‐fit, the entire column/row structures must be selected. 
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Fill Handle 

The Fill Handle is in the bottom right corner of the selected cell. When 

you place your mouse over this handle, it changes from a thick white 

cross, to a thin black cross. Once you see the thin cross (no arrows) you 

can click and drag the cell to fill its contents in a single direction (up, 

down, left or right). If you want to go in two directions, you must first 

complete one way, let go of the mouse and then drag the handle in the 

second direction. 

When you use the Fill Handle to pull down a single number or plain text, it will copy the data. When you 

use the Fill Handle to pull down a text with numbers, a date, a month or a weekday it will fill in a series. 

 

Text    123    Exam 1    2/1/02   February   Friday 

Text    123    Exam 2    2/2/02   March    Saturday

Text    123    Exam 3    2/3/02   April    Sunday 

 

When you select two or more numbers (including dates) and then use the Fill Handle, Excel will fill in the 

series, following the original pattern of the selected cells. It can only follow simple addition and 

subtraction patterns. 

 

123    5    100    2/01/17 

124    4    110    2/08/17 

125    3    120    2/15/17 

126    2    130    2/22/17 

Building an Equation 

You can directly type in values, but that data stays constant. If you want to have the answers to your 

equations update as you change your data, you should use the cell addresses. You will see the cell 

addresses change colors so you can tell which ones are used in your equation. 

Type in the exact cell address 

Cells are labeled by their row and column headings. Rows are numbered and go horizontally across 

(rows of chairs) and columns are lettered and go vertically top to bottom (columns of a building). When 

we refer to the address of a cell, we use the column letter then the row number such as A1. 

- Click in the cell where the answer will appear 

- Press the Equal sign (=) 

- Type in the cell address you want to use in your equation 

- Accept the answer or press the next math operator (+, ‐, *, /, ^) 

 

  A  B  C 

1  1  2  =a1+b1 

2       
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Use the mouse to point to the cell address 

The mouse and arrow keys are both "pointers". If you press the equal sign and then use the mouse to 

click on another cell, Excel will put you into a "POINT" mode, and place the address of the cell you 

clicked on in your equation. 

- Click in the cell where the answer will appear 

- Press the Equal sign (=) 

- Use the mouse to click on the cell you want to use in your equation 

- Accept the answer or press the next math operator (+, ‐, *, /, ^) 

 

  A  B  C 

1  1  2  =A1 

2       

 

Mathematical Operations 

To let Excel know you expect it to "do math" you need start your cell with an equal sign (=). 

‐ Addition, plus sign (+)  = 5+2  result  7 

‐ Subtraction, hyphen (‐)  = 5‐2  result  3 

     (also used for negative)  = ‐5  result  ‐5 

‐ Multiplication, asterisk (*)  = 5*2  result  10 

‐ Division, slash (/)  = 5/2  result  2.5 

‐ Exponent/Power, caret (^)  = 5^2  result  25 
 

AutoSum 

We can build equations to do math on a large number of cells, but there are functions built into Excel 

that can help us automate the most common ones: Sum, Average, Count, Maximum, Minimum. On the 

far right of the Home tab you'll find the sigma ( ∑ ).  
 

 

When you click on the word AutoSum, you'll get a sum 

function. There is a dropdown list at the end of the 

button that will show more function options. 

The AutoSum button looks for numbers above or to the 

left of the cell to choose the range (the set) of numbers.  

Make sure to press enter or click the check to accept as 

soon as the function shows up. If you click outside the 

cell while you see the function, you may break the 

equation. 
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Exercise 1: Customers 

 

Resizing Columns 

1) Put your mouse on the line between any two Column 

letters. It will turn into a 2‐way arrow.  

a. Hold down the mouse button and drag to resize  

b. Double‐click between the headings to "AutoFit" 

 

2) Select the entire worksheet by clicking on the triangle above the Row 1, left of the Column A 

a. Try to resize any Column; all the selected columns will change 

b. Double‐click between the headings to have it "Auto fit" 

 

Freeze Panes (Lock Titles to Top of Page) 

1) Press Ctrl‐Home on the keyboard to return to Cell A1 

 

2) Turn to the View Tab in the Ribbon 

 

3) Find the Option Freeze Panes  

a. Choose Freeze Top Row 

b. Scroll down through the worksheet to see the titles in Row 1 stay at the top 
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Format 

1) Click on the Row Heading for Row 1 (click on the number 1) to select the entire row 

 From the Home Tab, or right‐click menu, choose B for bold  
 

2) Click on the Column Heading for Column G to select the entire Column 

 From the Home Tab, choose $ for an accounting format 

 Adjust the Column width again 
 

3) Find a street name with a "fruit" address and use the Fill button (the bucket   ) to shade it a 

peach/orange color 

 Change a few of them to match 
 

4) Find a street name with a "vegetable" address and use the Fill bucket to shade a greenish color 

 Change a few of them to match 

 

 

 

   



 

10 

Exercise 2: Quarter Total 

Turn to the next worksheet at the bottom of the window, Quarter Total. 

Fill Handle 

1) If needed, Move to Cell A1 

a. Hover your mouse over the bottom right corner 

of the cell until it turns into a thin crosshair/plus 

sign. This is called the Fill Handle. 

b. Drag the Fill Handle down to the bottom of Row 5 

c. Cells A1 through A5 now all say Quarter 

d. UNDO! 

 

2) Move to Cell A2 

a. In Cell A2 type: 1st Qtr 

b. Press Enter or the click the Check to accept 

i. If needed, return to Cell A2 

c. Drag the Fill Handle for Cell A2 to the bottom of Row 5 

i. 1st Qtr, 2nd Qtr, 3rd Qtr, 4th Qtr 

Format 

1) Select titles in Cells A1 and B1 

a. Bold 

b. Bottom Border 

c. Center 

 

2) Select the numbers in Cells B2, B3, B4, and B5 

a. Comma Format 

b. Decrease Decimals to zero/none 

 

Chart 

1) Return to Cell A1 (Ctrl‐Home) 

 

3) From the Insert tab, Recommended Charts 

a. Opens the Insert Chart window 

 

2) Click OK to accept the Column Chart option 
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Exercise 3: Items by Quarter 

Turn to the next worksheet at the bottom of the window, Items by Quarter. 

Insert Rows 

1) Select Row 1 and Row 2 

 Click on the row heading 1 and drag to 

row heading 2 
 

2) Right‐click Inside the selection 

 Choose Insert 

 

Merged Title 

1) In Cell A1 type: Quarterly Sales Report 
 

2) Select Cells A1 through E1 

 Click the Merge and Center button 
 

3) Format: Bold, Fill, Border 

 

Fill Handle Across 

1) In Cell B3, delete Qtr 1, and type: 1st Qtr 
 

2) Drag the fill handle for Cell B3 across to Cell E3 
 

3) Center and Bold the new titles 

 

Total Row (AutoSum) 

1) In Cell A8 type: TOTAL 
 

2) In Cell B8 Click on the AutoSum button 

 =SUM(B4:B7) 

 Press Enter or click the check to accept (2079) 
 

3) Drag the Fill handle in Cell B8 to Cell E8 to fill in the "sum" pattern for each quarter 

 

 

 

   

The Fill Handle is the small square in the 

bottom right corner of a selected cell. 
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Exercise 4: Sales Report 

Turn to the next worksheet at the bottom of the window, Sales Report. 

Format 

1) Row 1 ‐> Bold 

 

2) Column B ‐> Accounting ($) 

 

3) Column C ‐> Centered Aligned 

 

4) Cell C5 ‐> Right Aligned 

 

Math 

Total for each line item will be the Price times the Quantity.  

1) Go to Cell D2 

 

2) From the keyboard Type:    = 

 

3) With the mouse click on Cell B2 ($10.00)  

 Cell D2 should now have =B2 

 

4) From the keyboard type:    * 

 

5) With the mouse click on Cell C2 (5) 

 Cell D2 should now have =B2*C2 

 

6) Press Enter or click the check to accept 

 Answer: $50.00 

 If needed return to Cell D2 

 

7) Drag the Fill Handle for Cell D2 to Cell D4 

to fill in the pattern for the formula 

 

Grand Total 

1) Move to Cell D5 

 

2) From the Home tab click on the AutoSum  ∑ 
 =SUM(D2:D4) 

 

4) Press Enter or click the check to accept  

 Answer: $600.00 

 

3) Change Cell B2 to $12.50 and press 

enter or click the check to accept 

 Grand Total should be $612.50 
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UNDERSTANDING WORKBOOKS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In Microsoft Excel the data you enter, whether it 
consists of numbers, text, or formulas, is stored 
in a file known as a workbook. Workbooks are 
just like huge electronic books with pages (or 

sheets) that have been ruled into columns and 
rows. Before using Excel it is helpful to know what 
the various parts and elements that make up a 
workbook are. 

 

A worksheet (or page) in a workbook contains 16,384 columns that are labelled using letters of 
the alphabet. The first column in a worksheet is labelled column A, while the last is labelled XFD 

 

A worksheet (or page) in a workbook contains 1,048,576 rows that are labelled using numbers 
from 1 to 1,048,576 

 

Where a column and row intersect we get what is known as a cell. You enter your data into 
these cells. Each cell in a worksheet can hold up to 32,767 characters – although it would be 
unrealistic to ever push it this far. Cells are referred to by their column and row labels. For 
example, in the screen above the cell we are pointing to is C11 – this reference is known as the 
cell address and is most important as it is frequently used in commands and formulas 

 

When you start typing something, you want it to appear somewhere in the worksheet. As a 
consequence when the Status Bar shows Ready mode, at least one cell in the worksheet will be 
highlighted – this is known as the active cell. In the screen above, the active cell is cell A1 – 
notice that the column label and the row label also appears coloured to indicate the active cell. 
You can have more than one active cell – when this occurs you have what is known as a range 

 

A workbook (as you would expect) is made up of pages known as worksheets. You can have as 
many sheets in a workbook as your computer resources can accommodate. As a default, a new 
blank workbook normally has 3 worksheets labelled Sheet1, Sheet2, and Sheet3. Of course 
these labels are pretty boring and meaningless and can be changed to something more relevant 

 

The Insert Worksheet button here will insert another worksheet into the current workbook 
should you need it 

 

1 
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NAVIGATING IN A FILE 
 

Arrow 

Keys 

Move one cell to the right, left, up or down 

Tab Move once cell to the right 

Ctrl+Home To beginning file 

Ctrl+End To end of typed information 

Home Beginning of a line 

End End of a line 

Page Down Down one screen 

Page Up Up one screen 

F5 To a specific page 

Scroll bars 
Appear at the right and on the bottom of the screen. You may click 

the scroll arrows, drag the scroll box or click the scroll bar to move 

through the document. 
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TYPING TEXT OR NUMBERS INTO A WORKSHEET 
 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

  

 

 

 

 

 

 

 

  

 

 

 

  

Generally when you start a new spreadsheet 
project, the first task is to enter some headings 
into rows and columns. To type anything into a 
worksheet you need to make the cell into which 

you wish to enter the data active. This can be done 
in a number of ways but the most common is to 
click in it first before typing.  

Try This Yourself: 

 

Before you begin ensure 
that there is a blank 
workbook on the screen… 

 
Click in cell A3 to make 
this the active cell, type 
Garden Settings and 

press   

When you press  the 

next cell down 
automatically becomes 
the active cell. By the 
way, even though the text 
looks like it is in cells A3 
and B3 it really only is in 
cell A3 – since there is 
nothing in B3, Excel 
allows the spill over to be 
displayed giving the 
illusion it is in 2 cells… 

 
Type Pool Covers and 

press   

 
Repeat the above steps 
and enter the remaining 
text in column A as shown 

 
Click in cell B2 to make 
this the active cell, type 
UK and press   

When you press   the 

cell to the right becomes 
the active cell… 

 
Enter the remaining text in 
row 2 as shown 

 

For Your Reference… 

To enter text: 

1. Click the cell pointer on the desired cell and 
type the required information 

2. Press , an arrow key or  to 

confirm the data entry and to move the cell 
pointer to another cell 

Handy to Know… 

 You don’t have to use   or  to make 

adjacent cells active. You can simply use the 
mouse and click in the cells if you want or 
even press the arrow keys to move up, 
down, left, or right. 

1 2 

3 

4 

5 

For Your Reference… 

To save a new document: 

1. Click on the File Tab and select Save As 

2. Locate the storage folder in the Navigation 
pane 

3. Type a File name and click on [Save] 

Handy to Know… 

 In the exercise above we have named the 
workbook Garden Department Sales and 
filed it in C:\Course Files for Excel 2010. 
Each time you start Excel it will most likely 
assume you want to file your workbooks in a 
folder called Documents which is associated 
with the user name you use on the computer. 
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TYPING SIMPLE FORMULAS IN A WORKSHEET 
 

 

 

 

 

   

 

 

 

 

 

 

 

  

 

 

 

 

 

 

   

 

 

 

 

 

 

 

The whole idea behind Excel is to get it to 
perform calculations. In order for it to do this you 
need to type formulas in the worksheet. Usually 
these formulas reference existing numbers, or 

even other formulas, already in the worksheet 
using the cell addresses of these numbers rather 
than the actual value in them. Formulas must be 

typed beginning with an equal sign (=). 

For Your Reference… 

To enter a formula: 

1. Click the cell pointer on the desired cell and 
type the formula commencing with = 

2. Press , an arrow key or  to 

confirm the data entry and to move the cell 
pointer to another cell 

Handy to Know… 

Operators  

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

 

Try This Yourself: 

 Continue using the previous 
file with this exercise... 

 
Click in cell B8 to make this 
the active cell 

 
Type =B3+B4+B5+B6+B7 and 
examine what is happening on 
the screen 

 
Press  to enter the formula 

and move to the next cell 

Notice that a calculation has 
now been performed. We have 
entered a formula in B8 that 
says “add the values in B3, B4, 
B5, B6, and B7 and show them 
here”… 

 
Ensure that C8 is the active 
cell, type =SUM(C3:C7) and 

press   

This is an alternative type of 
formula known as a “function”. 
Again a calculation will appear 
in the cell… 

 
Click in cell B8 and notice that 
the formula you typed appears 
in the Formula Bar, while the 
result of the calculation 
appears in the worksheet 

 
Repeat step 5 with cell C8 

 Click on the File Tab  
and select Save to save the 
additions that have been made 
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FILLING A SERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A series refers to a sequence of ordered entries 
in adjacent cells, such as the days of the week or 
months of the year. The fill technique can be 
used to create these in a worksheet for you,  

reducing the amount of time taken for data entry, 
and ensuring that the spelling is correct. Excel 
provides days and months as special built-in series 
that you can access. 

 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file E707 
Filling_1.xlsx... 

 
Click on cell A4 

 
Move the mouse pointer to the 
small square (the fill handle) 
at the bottom right corner of 
the cell until the mouse pointer 
appears as a thin, black cross 

 
Drag the mouse pointer to 
column F 

Excel will fill the range with the 
first six months of the year… 

 
Click on cell A5 and repeat 
steps 2 and 3 to create the 
series of months with their full 
names 

You can also fill more than one 
row at a time… 

 
Select the range A6:A12 

 
Repeat steps 2 and 3 to fill 
across to column F 

 
Examine each of the series 
created by the filling process 

 

For Your Reference… 

To fill a series: 

1. Click on the first cell in the series 

2. Drag from the fill handle across as many 
columns as required 

Handy to Know… 

 As you drag the fill handle across, a tool tip 
appears below the fill pointer displaying the 
current value in the series. This is really 
handy when you want to end on a particular 
month, day or value. 

2 

3 

6 
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INSERTING AND DELETING WORKSHEETS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once you’ve decided on a structure for your 
workbook, you may find that there are some 
worksheets that can be deleted. Alternatively, 
you may find that you need additional blank 

worksheets inserted. However, remember that 
deletion of worksheets is permanent and can’t be 
undone using Undo, so always save your 
workbook before making these changes. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this exercise 
you MUST open the file 
E1324 Worksheet 
Techniques_1.xlsx… 

 
Examine the workbook – it 
currently contains one 
worksheet named Sheet1 

 
Click on the New Sheet icon 
at the end of the worksheet 
tabs 

A new worksheet named 
Sheet2 will be inserted. You 
can also use the keyboard 
shortcut... 

 
Press  +  to insert 

another new worksheet 

This sheet is named Sheet3 
and is inserted before the 
currently selected sheet. 
Now let’s delete a sheet... 

 
Right-click on the Sheet3 
worksheet tab to display the 
shortcut menu 

 
Select Delete to remove the 
worksheet 

As the worksheet contains no 
data, the sheet will be 
deleted immediately. If a 
worksheet contains data, 
Excel will ask you to confirm 
your actions... 

 
Repeat steps 4 and 5 to 
delete Sheet2 

 

1 

2 

3 

4 

For Your Reference… 

To insert a new worksheet into a workbook: 

 Click on the New Sheet icon to the right of 
the worksheet tabs 

To delete a worksheet from a workbook: 

 Right click on the worksheet tab, then select 

Delete 

Handy to Know… 

 To insert a worksheet between existing 
worksheets, right-click on the worksheet tab 
before which you want to insert a new sheet, 
then click on Insert to display the Insert 
dialog box. Select Worksheet and click on 

[OK]. 

5 
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COPYING A WORKSHEET 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Just as you can copy the contents of cells and 
ranges within a worksheet, you can duplicate 
worksheets within a workbook. This technique is 
ideal for replicating layouts. For example, if you 

have a budget workbook that contains data for 
several departments, you can create a worksheet 
for the first department and then copy it to create 
identical worksheets for other departments. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file E1324 Worksheet 
Techniques_1.xlsx... 

 
Right-click on Sheet1 to 
display the worksheet shortcut 
menu 

 
Select Move or Copy to 
display the Move or Copy 
dialog box 

 
Click on Create a copy so it 
appears ticked, then click on 
[OK] 

The new worksheet is named 
Sheet1 (2). Let’s create a 
“template” from this worksheet 
by deleting unwanted data... 

 
Select the range B7:E9, then 
press  to clear it 

 
Repeat step 4 to clear the 
ranges B14:E23, G7:J9 and 
G14:J23, then press  + 

 to return to cell A1 

Now we can copy this 
“template” to create additional 
worksheets... 

 
Repeat steps 1 to 3 three 
times to create three copies of 
the template worksheet – this 
time without data 

The final worksheet should be 
named Sheet1 (5) 

 

1 

2 

For Your Reference… 

To copy a worksheet: 

1. Right-click on the worksheet to copy, then 
select Move or Copy 

2. Click on Create a copy so it appears ticked 

3. Click on [OK] 

Handy to Know… 

 You can copy the current worksheet using 
the HOME tab by clicking on Format in the 
Cells group, then clicking on Move or Copy 
Sheet. 

 The Before sheet options in the Move or 
Copy dialog box allow you to position the 
copied worksheet where you want. 

3 

6 
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RENAMING A WORKSHEET 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By default, Excel names worksheets as Sheet1, 
Sheet2, Sheet3, etc. These names are fine if you 
are not planning to share the workbook, but 
changing these to something more relevant 

makes it much easier to understand the purpose of 
a worksheet. You can also adjust the horizontal 
scroll bar to make room for longer, more 
meaningful worksheet names. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file E1324 Worksheet 
Techniques_2.xlsx... 

 
Point to the vertical dots 
between the sheet names and 
the horizontal scroll bar, as 
shown 

The pointer will change to a 
double-headed arrow... 

 
Click and drag the bar across 
to the right, to the end of 
column L, then release the 
mouse button 

 
Double-click on Sheet1 (5) to 
select the worksheet tab name  

This will also place it into edit 
mode… 

 
Type Comms, then press  

 
Repeat steps 3 and 4 to 
rename the other worksheets: 

Sheet1 (4) Admin 
Sheet1 (3) Shop 
Sheet1 (2) IT 
Sheet1 Maintenance 

 

1 

3 

4 

5 

For Your Reference… 

To rename a worksheet: 

1. Double click on the current name on the 
worksheet tab 

2. Type the new name and press   

Handy to Know… 

 You can rename a worksheet by 
right-clicking on the worksheet tab to display 
the shortcut menu and clicking on Rename. 

 A worksheet tab name can contain up to 31 
characters including spaces, but it is better to 
keep it short and succinct. 



Microsoft Excel 

ITTraining@sgul.ac.uk Page 9 St. George’s Information Services 

MOVING OR COPYING A SHEET TO ANOTHER WORKBOOK 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can copy worksheets to other workbooks as 
required. For example, you might need to keep 
records for six different divisions – rather than 
send each division the entire set of records, you 

can copy their worksheet to another workbook and 
send them their data only. If worksheets exist in the 
other workbook, you will need to determine the 
order in which to place the copied worksheet. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
E1324 Worksheet 
Techniques_6.xlsx... 

 
Click on the Maintenance 
worksheet tab 

We’ll copy this completed 
data to another workbook... 

 
Right-click on the 
worksheet tab to display 
the shortcut menu, then 
click on Move or Copy to 
display the Move or Copy 
dialog box 

 
Click on the drop arrow for 
To book, then select (new 
book) 

 
Click on Create a copy so 
it appears ticked 

This will create a new 
workbook as well as 
making a copy of the 
worksheet... 

 
Click on [OK] 

A new workbook will be 
created and Maintenance 
will be the only worksheet 
in the workbook… 

 
Save the new workbook as 
Maintenance.xlsx, then 
close it 

 

1 

2 4 

For Your Reference… 

To copy a sheet to another workbook: 

1. Right click on the worksheet tab, then click 
on Move or Copy 

2. Select either (new book) or the name of 
another workbook in To book 

3. Tick Create a copy, then click on [OK] 

Handy to Know… 

 To copy a worksheet into an existing 
workbook, make sure that you open the 
destination workbook first to ensure that it is 
listed in To book in the Move or Copy 
dialog box. 

5 
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CHANGING WORKSHEET TAB COLOURS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To make it easier for you to distinguish between 
worksheets, Excel enables you to change the 
colours of worksheet tabs. This allows you, for 
example, to quickly distinguish between different 

financial years, departments or months. The active 
sheet appears as underlined in a gradient version 
of the selected colour, while inactive tabs will 
display a solid colour background. 

2 
Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file E1324 Worksheet 
Techniques_7.xlsx... 

 
Click on the Admin 
worksheet tab to select the 
worksheet 

 
Right-click on the worksheet 
tab to display the shortcut 
menu, then point to Tab 
colour  

This will display a palette of 
colour options… 

 
Click on Red under 
Standard colours to apply 
the colour to the tab 

 
Right-click on the 
Maintenance worksheet tab 
to display the shortcut menu, 
click on Tab colour, then 
click on Blue under 
Standard colours 

Notice how the Admin 
worksheet tab colour is now 
a solid rather than a 
gradient… 

 
Repeat either technique to 
apply the following colours: 

Shop Yellow 
IT Green 

 
Click on the Admin 
worksheet tab to view the 
results 

 

3 

4 

5 

6 

For Your Reference… 

To change the colour of a worksheet tab: 

1. Right-click on the worksheet tab to display 
the shortcut menu 

2. Point to Tab colour to display a palette of 
colour options 

3. Click on the desired colour 

Handy to Know… 

 To apply the same colour to two or more 
sheets at once, select them first. Hold down 

 to select consecutive worksheets or 

hold down  to select non-consecutive 

worksheets. 
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GROUPING WORKSHEETS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Worksheet grouping enables you to make the 
same change at once to all selected worksheets. 
This feature is useful in situations where your 
worksheets have identical layouts or text. For 

example, if you want to format the heading for 
multiple worksheets, you simply group the 
worksheets, make a change to one worksheet and 
the other worksheets will reflect the change also. 

1 
Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the previous 

file with this exercise, or 
open the file E1324 
Worksheet 
Techniques_8.xlsx... 

 
Click on the Admin 
worksheet tab, hold down 

, then click on the Shop 

worksheet tab to select the 
first three worksheets 

 
Click in cell A1 to select the 
cell 

 
Click on the HOME tab, then 
click on Italics in the Font 
group 

This will italicise the text in 
cell A1 on this and all other 
worksheets in the group… 

 
Click on the Maintenance 
worksheet tab, then the 
Shop worksheet tab to see 
that the changes have been 
applied here 

 
Click on the IT worksheet 
tab to see that the changes 
have not been applied to 
this worksheet  

Since this was not part of 
the grouped sheets the 
changes have not been 
applied here. Notice too that 
clicking on a tab deselects 
the previous grouping 

 

2 

3 

4 

5 

For Your Reference… 

To group worksheet tabs: 

1. Click on the first worksheet tab 

2. Hold down , then click on the last 

worksheet tab 

Handy to Know… 

 To deselect a group, either click on the tab of 
a worksheet that is not in the group, or right-
click on a tab and select Ungroup Sheets. 

 Most formatting and text changes done on a 
worksheet in a group will be applied to other 
sheets in that grouping. 
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FREEZING ROWS AND COLUMNS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you lay out your data in rows and columns, 
it is most likely that your headings end up at the 
top or to the left of your data. If you have a large 
amount of data, you may find that when you 

scroll across or down to particular cells, the 
headings scroll out of view. This problem can be 
resolved by freezing the rows and/or columns that 
hold the headings. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous file 
with this exercise, or open the file 
E1324 Worksheet 
Techniques_11.xlsx... 

 
Click on the Maintenance 
worksheet tab, then spend a few 
moments examining the worksheet 

Depending on your screen, it is 
possible that you won’t be able to 
see all of the figures on the screen 
at once... 

 
Click in cell B6 to select the cell 

 
Click on the VIEW tab, click on 
Freeze Panes in the Window 
group, then select Freeze Panes 

Thin black lines appear above and 
to the left of the selected cell. This 
indicates that the areas above and 
to the left are frozen... 

 
Scroll to the right until Yearly 
Average in column L appears next 
to column A 

 
Scroll down until Overheads in row 
25 is below row 5 

 
Press  +  to move to cell 

B6 – this is our temporary home 
cell, as the cells above and to the 
left are frozen 

 
On the VIEW tab, click on Freeze 
Panes in the Freeze Panes group, 
then click on Unfreeze Panes to 
unfreeze the rows and columns 

 

3 

4 

For Your Reference… 

To freeze panes in a worksheet: 

1. Click in the cell below and to the right of the 
area you want to freeze/unfreeze 

2. Click on the VIEW tab 

3. Click on Freeze Panes in the Window 

group, then select Freeze Panes 

Handy to Know… 

 If you want to freeze only the rows above the 
selected cell (leaving all columns unfrozen), 
select the cell in column A of that row – e.g. 
to freeze rows 1 to 6, click in cell A7. The 
same applies to freezing only columns and 
leaving the rows unfrozen: select the cell in 

row 1. 

5 
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SELECTING RANGES 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

  

 

 

 

 

  

 

 

 

 

 

 

 

A contiguous range is any group of selected 
cells that form either a square or a rectangle. A 
single cell that is selected is also considered to 
be a range. Ranges can be selected using the 

mouse, the keyboard or a combination of the two. 
Once selected, you can use the range for input, or 
apply formatting, or copy the cells as required. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise you 

MUST open the file E705 
Ranges_1.xlsx... 

 
Click on cell B7 to select it 

Because it is the only cell 
selected it is the active cell… 

 
Hold down the  key and 

click in cell E10 

Even though a range has been 
selected, the active cell is B7 – it 
appears in a different colour and 
its contents appear in the 
formula bar. You can keep the 
range selected and change the 
active cell within the range using 
the keyboard… 

 
Press  several times and 

watch the various cells become 
active through the selection 

 
Click in cell B7, hold down the 
mouse button, and drag down to 
cell C10 before releasing the 
mouse 

The previous selection has 
disappeared and the range B7 
to C10 is now selected… 

 
Press  and  to 

deselect the selected cells and 
return the cell pointer to cell A1 

 

For Your Reference… 

To select ranges with the mouse: 

1. Click in the left-most cell of the range 

2. Hold down the  key and click in the 

last cell, Or 

3. Drag the mouse pointer to the bottom right 
corner of the range 

Handy to Know… 

 When a range has been selected it can be 
used as an input range. You can then enter 
data into the active cell and move the active 

cell to either the cell below by pressing , 

or the adjacent cell by pressing . 

1 

2 

3 

4 
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SELECTING ROWS 
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you want to make changes to an entire row, 
such as bolding all of the headings in a row or 
changing the font of all the cell entries, you must 
first select the row. This is done by clicking on the 

row header to the left of the row. Remember that 
any changes you make will apply to every cell in 
the row all the way across to column XFD, so be 
careful! 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the file 
E705 Ranges_1.xlsx... 

 
Press  +  to make cell A1 

the active cell 

 
Move the mouse pointer to the 
row heading for row 5 

Notice that the mouse pointer 
changes to a black arrow that 
points towards the row… 

 
Click once on row heading 5 to 
select the entire row 

 
Click in cell B7and press  + 

 

This is the key combination for 
selecting an entire row… 

 
Click on the row header for row 7 
to select this row 

 
Hold down  and click on the 

row header for row 10 

All rows from 7 to 10 will be 
selected… 

 
Click in the row header for row 5, 
then hold down the left mouse 
button and drag down the row 
headers to row 10 

This is another technique for 
selecting rows, but it does require 
a steady hand! 

 

For Your Reference… 

To select an entire row: 

1. Click on the row header of the row that you 
want to select 

OR 

1. Click in any cell in the row and press 

 +  

Handy to Know… 

 When every cell in a row or column is 
selected, the corresponding row or column 
header is filled in dark blue. When only some 
of the cells are selected, the row or column 
header is filled in orange. These indicators 
help you locate the active cell(s) on the 
worksheet. 

  

2 

3 

4 

6 

7 
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SELECTING COLUMNS 
 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

  

 

 

 

 

 

 

 

  

If you want to make changes to an entire 
column, such as bolding all of the headings in a 
column or changing the font of all the cell entries, 
you must first select the column. This is done by 

clicking on the column header directly above the 
column. Remember that any changes you make 
will apply to every cell in the column all the way 
down to row 1,048,576! 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file E705 Ranges_1.xlsx... 

 
Press  +  to make 

cell A1 the active cell 

 
Move the mouse pointer to the 
column heading for column B 

Notice that the mouse pointer 
changes to a black arrow 
pointing down the column… 

 
Click once to select the column 

This time the row headers 
change to orange to indicate 
that at least one cell (but not 
all) in each row is selected… 

 
Click in cell D6 and press  

+  

This key combination also 
selects an entire column… 

 
Click on the column header for 
column B to select it 

 
Hold down  and click on the 

column header for column D 

This time, columns B, C, and D 
are all selected… 

 
Click in the column header for 
column A, then hold down the 
left mouse button and drag the 
mouse pointer across the 
column headings to column E 

 

For Your Reference… 

To select an entire column: 

1. Click on the column heading of the column 
that you want to select 

OR 

1. Click in any cell in the column and press 

 +  

Handy to Know… 

 Make sure that you check your worksheet 
carefully after you’ve made changes to entire 
columns. Remember that all of the cells in 
that column are affected – even those in 
rows below the visible area. 

2 

3 

4 

6 
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UNDERSTANDING FORMATTING 
 

 

 

 

  

 

In Excel there are always two aspects to a 
number: how the number presents on the screen 
(known as formatting) and the underlying value 
of the number. Take 2% as an example – on the 

screen it is formatted to appear as a number with a 
percentage sign, whereas the real value in the cell 
is .02. 

Number Formatting – The Veil Placed Over Numbers 

All calculations in Excel are performed using numbers – this is only logical. So, when you want to perform 
a calculation, you type the numbers in various cells, then create formulas to reference those numbers. 
How do you show what those numbers represent? For example, how do you show you are working with 
currency, or percentages, or even dates (which in Excel are really numbers)? 

Excel allows you to show these representations using number formatting. With number formatting you 
change the way a number looks so that it makes immediate sense to the reader of your worksheet. The 
underlying value of number, however, remains unchanged. For example, instead of showing sales tax in 
a worksheet as .1 you show it as 10%, to show 12889.95 as currency it would appears $12,889.95 or 
€12,889.95 (depending upon the currency you are working with), and to show 44104 as a date you show 
it as 30-Sep-2020 (remember, dates are actually numbers representing the number of days from January 
1, 1900). 

The following worksheet contains formatted numbers: 

With the formatting removed from the numbers the worksheet looks as follows: 

Formatting can also be applied as you type. For example, if you type 30/9/2020 Excel will place the 
number 44104 in the cell but will format this number as a date and show it as you typed it. There are also 
a range of number formatting options on the ribbon that allow you to apply formatting to numbers after 
they have been entered into a worksheet. 
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APPLYING GENERAL FORMATTING 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Number Format command in the Number 
group on the HOME tab contains a drop arrow 
that provides a gallery of the more commonly 
used number formats. You can apply these  

formats easily and quickly to a selected cell or 
range of cells in the worksheet. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file E1315 
Number Formatting_1.xlsx… 

 
Click in cell D4, hold down 

, then click in cell D13 to 
select the range containing 
dates 

 
Click on the HOME tab, then 
click on the drop arrow for 
Number Format in the 
Number group to see a gallery 
of number formats 

 
Click on Long Date to make 
the short dates in the selected 
range appear as long dates 

 
Click in cell E4, hold down 

, then click in cell E13 to 
select the range containing 
units of measure 

 
Click on the drop arrow for 
Number Format, then select 
Number to display these as 
numbers with 2 decimal places 

 
Repeat the above steps to 
change G4:G13 to Currency 

 
Repeat the above steps and 
change the following ranges 
as shown: 

H4:H14 Percentage 
I4:I4 Accounting 
G15:I15 Currency 

 

2 

For Your Reference… 

To apply general formatting to numbers: 

1. Select the range to format 

2. Click on the HOME tab, then click on the 
drop arrow for Number Format in the 
Number group  

3. Click on the desired number format 

7 

Handy to Know… 

 Excel may appear to round values up or 
down as necessary – however, the value in 
the cell does not change. Sometimes you’ll 
see minor rounding discrepancies. 

 The Currency format shows the currency 
format and symbol appropriate to the country 
your computer is configured for. 
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CHANGING FONTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

The appearance that you choose for your text is 
referred to as the font or typeface. Font 
traditionally refers to a combination of typeface, 
style and size in points (e.g. Arial Bold 12 pt).  

In Excel 2007, font just refers to the typeface or 
shape of the letters. Typical classic fonts include 

Times New Roman, Arial, Century Gothic and 

Copperplate. 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file E722 Font 
Formatting_1.xls... 

 
Click in cell A1 to make the 
cell with the main heading the 
active cell 

 
Click on the drop arrow next to 

the Font command  in 

the Font group on the Home 
tab to display a gallery of 
available fonts 

 
Point to Arial Narrow, then Book 
Antiqua, Garamond and Gill 

Sans MT 

If you don’t have these fonts, 
try different ones. As you point 
to each font, the preview will 
change... 

 
Scroll to and click on Comics 

Sans MS, or another font of 

your choice if you don’t have 
this one 

This time the font formatting 
has changed in the cell and is 
no longer just a preview – it 
won’t change again unless you 
make another font selection. 

 

For Your Reference… 

To apply font formatting: 

1. Select the text 

2. Click on the drop arrow  for Font 

3. Point to a font to preview it 

4. Click on the font to apply it 

Handy to Know… 

 You can jump directly to a font. For example, 
if you want to preview Garamond, click on the 

name of the font in the Font command and 

press . Excel will jump to the fonts that 

start with G and Live Preview will display the 
text temporarily. Keep typing the name until 
you reach the required font. 



1 

4 
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CHANGING FONT SIZE 
 

 

 

 

  

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

   

 

 

 

 

One way that text can be emphasised is by 
changing the size of the font. For example, if 
your normal text is 11 pt, you may like to make 
the headings 13 pt or larger. Font size may also  

be changed for small detailed items, such as 
comments or a caption. Main headings in a 
worksheet usually appear in a slightly larger font 
size compared to the rest of the data. 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file E722 Font 
Formatting_2.xlsx... 

 
Click in cell A1 to make the 
cell with the main heading the 
active cell 

 
Click on the drop arrow next to 
the Font Size command 

 in the Font group on 

the Home tab to display a 
gallery of available sizes 

 
Point to various sizes and 
notice how Live Preview 
shows you how the heading 
will look 

 
Click on 16 to change the 
heading to 16 pt 

You can also change the font 
size of parts of a document, 
and you can use the Mini 
toolbar... 

 
Click in cell A2 

 
Click with the right-mouse 
button to display the mini-
toolbar and the shortcut menu 

 
Click on the drop arrow next to 

Font Size  and 

click on 14 

 
Click in cell A3 to hide the 
toolbar 

 

For Your Reference… 

To change font size: 

1. Select the cell or range that you want to 
change 

2. Click on the drop arrow of Font Size   

3. Click on the required font size 

Handy to Know… 

 You may have noticed that the text didn’t 
change size when you used the mini toolbar 
until you actually clicked on a different font 
size. This is because Live Preview doesn’t 
work with the mini toolbar. 

1 

2 

8 
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UNDERSTANDING BORDERS 

 

 

 

 

 

 

 

Borders are lines that are placed around the 
edges of individual cells or ranges. The lines may 
be thin, thick, solid, dashed, black or coloured, or 
even double lines. The reason for using borders 

is that the lines can be used to group together data 
or indicate totals, or to draw the user’s attention to 
critical cells that may need special data entry. Here 
are some examples. 

A Worksheet without and with Borders 

Borders can be used to apply a structure. Here’s the same worksheet shown without borders and 
then with borders applied. The use of borders helps to highlight the totals and separate them from 
the other data. 

Border Variations 

Borders can be applied to all four sides of a cell, or to individual sides of a cell. The following 
examples show a cell without a border, with an outside border and a top and double bottom border. 
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APPLYING A BORDER TO A RANGE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can apply a border to a range of cells. This 
allows you to place an outline around them to 
indicate that the cells are somehow related to 
each other, or to place borders between cells to 

indicate that they are in separate groups. Borders 
can be used in ranges of cells to create a more 
form-like appearance. The borders available for 
single cells can also be applied to ranges. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file E730 Applying 
Borders_2.xlsx... 

 
Select the range A5:A11 

 
Click on the drop arrow for 
Borders  and select 

Outside Borders 

 
Click away from the range to 
see the border 

An outline has been placed 
around the cells... 

 
Repeat steps 1 and 2 to apply 
an outline border to each of 
the following ranges in the 
order that they are listed: 

B5:B11, C5:C11, D5:D11, 
E5:E11, F5:F11, G5:G11, 
H5:H11, I5:I11, A5:I5, 
A11:I11 

B13:B19, C13:C19, 
D13:D19, E13:E19, F13:F19, 
G13:G19, H13:H19, I13:I19, 
A13:I13, A19:I19 

You can hold down  

and select several of these 
ranges at once before 
applying the border... 

 
Click away from the last 
selected range to see the 
result 

 

For Your Reference… 

To apply a border to a range: 

1. Select the range 

2. Click on the drop arrow for Borders  

in the Font group on the Home tab 

3. Click on the border option of your choice 

Handy to Know… 

 You can copy a border between cells, for 
example, from one table to another, using 
Paste Special. Select the cells, click on 

Copy , click on the first cell of the 

second range and click on the drop arrow for 

Paste . Select Paste Special, click on 

Formats and then click on [OK]. 

1 

3 

5 
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WRAPPING AND MERGING TEXT 
 

 

 

 

 

  

 

 

 

 

 

 

  

  

 

 

 

 

 

  

 

 

 

  

 

Microsoft Excel will allow long cell entries to spill 
across to other adjacent cells to the right as long 
as those cells are empty. If those cells contain 
data the spill-over will be chopped off. If you need 

to place long text entries in a cell you can arrange 
for Microsoft Excel to wrap the text within the cell 
and also merge that cell with others to 
accommodate the longer text entry. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file E723 
Cell Alignment_9.xlsx... 

 
Click in cell A5 

This cell contains a long text 
entry that spills across several 
columns… 

 
Click on the Expand Formula 
Bar tool  to the right of the 

formula bar to see all of the 
text 

 
Click on the Wrap Text 

command  in the 

Alignment group on the 
Home tab to wrap the text in 
cell A5 

Notice how the row height has 
now increased… 

 
Hold down the  key and 

click in cell E5 to select the 
range A5:E5 

 
Click on the drop arrow  

for Merge & Centre  in the 

Alignment group and select 
Merge Cells to merge the cells 
in the range 

 
Move the mouse pointer to the 
bottom of the row 5 heading 
border and drag the row height 
up until you reach 30 points 

 

For Your Reference… 

 To wrap text - click in the cell to merge and 

click on the Wrap Text command  in the 

Alignment group on the Home tab 

 To merge text - click on the drop arrow  

for Merge & Centre  in the Alignment 

group and select Merge Cells 

Handy to Know… 

 In the example above, wrapping forced the 
text into one cell and Excel expanded the 
row height so that all of the text was 
accommodated. We then merged the text 
across several horizontal cells in the exercise 
above so that we could reduce the row 
height to a more acceptable level. 

  

1 

3 

5 
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PRACTICE EXERCISE 

Font Formatting 

Tasks:  

 Before starting this exercise you MUST have completed all of the topics in 
the chapter Font Formatting… 

 

 
Open the workbook called PE_Font Formatting.xlsx (it can be found in 
the same folder as the student files) 

 

 
Format the heading in cell A1 as Cambria, 36 pt, bold, Orange Accent 2  

 
Format the other headings as bold, italic or underline as shown on the 
following page 

 

 
Use Orange, Accent 2, Lighter 80% to fill the area behind the headings 
as shown on the following page 

 

 
Add the superscript 1 in cell H3 and in cell B27 with the following comment 

1 Fee may be reduced as the result of Government Assistance 

Your completed worksheet should appear as shown on the following 
page... 

 

 
Use the Save As command to save the workbook as PE_Font Formatting 
(Completed).xlsx 
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PRACTICE EXERCISE 

Cell Alignment 

Tasks: Completed: 

 Before starting this exercise you MUST have completed all of the topics in 
the chapter Cell Alignment… 

 

 
Open the workbook called PE_Cell Alignment1.xlsx (it can be found in 
the same folder as the student files) 

 

 
Right-align the fees  

 
Left align the range B6:B21  

 
Centre align cells B23, B25 and B27  

 
Use the Save As command to save the workbook as PE_Cell Alignment1 
(Completed).xlsx 

 
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PRACTICE EXERCISE 

Number Formatting 

Tasks: Completed: 

 Before starting this exercise you MUST have completed all of the topics in 
the chapter Number Formatting… 

 

 
Open the workbook called PE_Number Formatting.xlsx (it can be found 
in the same folder as the student files) 

 

 
On the Cargo worksheet, apply formatting to the dates and figures so that 
they appear as shown in sample A on the next page 

This will involve applying a date format, thousands separator, setting the 
number of decimals and applying the currency format... 

 

 
On the Purchases worksheet, apply formatting so that the figures appear 
as shown in sample B on the following page 

The currency formats should be $, € Euro (€ 123), R English (South Africa) 
and ETB Amharic (Ethiopia) respectively. You’ll need to widen the columns 
a little to make room for the characters added by the formatting... 

 

 
Use the Save As command to save the workbook as PE_Number 
Formatting (Completed).xlsx 

 
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UNDERSTANDING FUNCTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Imagine having to create a formula that 
calculated the monthly payments on a loan, or 
the average of over 100 cells – these would 
require complex or long formulas that would be 

time consuming to develop. This is the role of 
hundreds of arithmetic functions that have been 
pre-programmed in Excel for you. 

Functions Overview 

Functions are simply pre-programmed formulas already provided for you in Excel which can perform 
calculations covering a wide range of categories including statistics, date and time arithmetic, financial 
calculations, lists, engineering, and more. 

Just like normal formulas that you create, functions must start with an equal sign. The equal sign is 
then followed by the name of the function (usually a descriptive name which indicates the purpose of 
the function). Most functions also require additional information known as arguments which are 
supplied to the function in brackets after the function name. Functions are therefore written as follows: 

=name(arguments) 

The arguments are quite often cell or range references that contain values that can be used in the 
function. For example, the commonest function is the SUM function which, as its name suggests, is 
used to sum or add values together. If you wanted to add all of the values in the cells from B10 to D15 
you would write this function as: 

=SUM(B10:D15) 

As you can see this is much simpler than writing your own referential formula which would look like: 

=B10+B11+B12+B13+B14+B15+D10+D11+D12+D13+D14+D15 

Imagine writing and proofing a formula where you had to add 200 cells! 

Typing Functions 

If you are familiar with the function that you need you can type it into a cell exactly the same way you 
type any other formula. If you are not sure if Excel has a function or you can’t quite remember how it is 

written you can use the Insert Function tool  on the Formula Bar to assist you. When you click on 

this tool the Insert Function dialog box will be presented to you which lists the most recently used or 
common functions and also allows you to search for other functions that you might need. 

 

The Insert Function dialog box will also type the function out for you and then provide you with a 
further dialog box to guide you through the process of specifying the arguments that the function 
needs to perform its calculation. 
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USING THE SUM FUNCTION TO ADD 
 

 

 

 

 

  

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

  

 

 

 

One of the most used functions is the SUM 
function. This function allows you to add the 
values in a range of cells. The function is written 
as: =SUM(range or ranges to add). You can  

type the function, and then use the pointing 
technique to fill in the arguments. Excel then paints 
marquees around the cells involved helping you to 
track your progress.  

 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file E710 
Formulas_4.xlsx... 

 
Click on B9 then type =sum( 
to start the formula 

 
Click on B6 to point to this cell 

as the start, hold down the  

key and click on B8 

Notice the relative addressing 
details, 3R x 1C, that appear in 
the tool tip… 

 
Type ) and press  to 

complete the function 

 
Click on B9, then move the 
mouse pointer to the fill handle 
on the lower right corner of the 
cell and drag across to E9 to 
fill the selected range with the 
equivalent functions 

 
Click on the Copy command 

 on the Clipboard group on 

the Home tab 

 
Click on B14, hold down  

and then click on cells B19 
and B24 

 
Release  and press  

to paste equivalent functions 
into the worksheet 

 

For Your Reference… 

To type a sum function for a contiguous range: 

1. Type =sum( 

2. Select the range of cells 

3. Type ) 

4. Press  

Handy to Know… 

 You can also use the Sum command in the 
Editing group on the Home tab of the 
Ribbon to have Excel automatically enter a 
sum function based on a range of cells. 

 You can also type the name of a function in 
upper or lowercase – it is not case sensitive. 

1 

2 

7 
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CALCULATING AN AVERAGE 
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The AVERAGE function allows you to average 
the values in a range of cells. It is written in much 
the same way as the SUM function, for example, 
=AVERAGE(range of cells to average). The 

average function can be applied using the 
Functions Wizard, a part of Excel that steps you 
through the process of creating a function or you 
can type it in yourself if you are comfortable with it. 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise, or open the 
file E710 Formulas_6.xlsx... 

 
Click on B29 then click on the 

Insert Function tool  to 

display the Insert Function 
dialog box 

 
Click on AVERAGE in Select a 
function then click on [OK] to 
display the Function 
Arguments dialog box 

 
Click on the Range Selector 

tool  for Number1 to roll up 

the wizard, then hold down  

and select the following ranges 

B6:B8 
B11:B13 
B16:B18 
B21:B23 

 
Press  to complete the 

range specifications, then click 
on [OK] to complete the process 

Let’s use the AutoSum 
function… 

 
Click on B34, then click on the 
drop arrow for the Sum 

command  on the Editing 

group, then select Average 

 
Click on B9, hold down  and 

click on B14, B19 and B24, then 

press  to complete the 

formula 

 

For Your Reference… 

To insert an average function: 

1. Click in the cell then click on the Insert 

Function tool   

2. Click on AVERAGE in Select a function  

3. Insert the required ranges then click on 

[OK] 

Handy to Know… 

 You can type queries like “How do I work out 
the monthly payment for a car loan?” into the 
Search box in the Insert Function dialog 
box. Once you have selected a function from 
the Select a function list, the Function 
Arguments dialog box will help you to enter 
the values into the function. 

  

3 

1 

5 
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FINDING A MINIMUM VALUE 
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

  

The Minimum or MIN function allows you to 
extract the lowest value from a range of values. It 
is written in much the same way as the SUM 
function. For example, =MIN(range of cells).  

The function can be applied using the Function 
Wizard, or by typing the function in detail directly 
into the cell. 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file E710 
Formulas_8.xlsx... 

 
Click on B31 then click on 

the Insert Function tool  

to display the Insert 
Function dialog box 

 
Click on the drop arrow  

for the Or select a category 
box and click on Statistical 

 
Scroll down and click on MIN 
in Select a function then 
click on [OK] to display the 
Function Arguments dialog 
box 

 
Click on the Range Selector 

tool  to roll up the wizard, 

then hold down  and 

select the following ranges: 

B6:B8  B16:B18 
B11:B13 B21:B23 

 
Press  to complete the 

range specifications, then 
click on [OK] to complete the 
process 

Let’s simply type the function 
this time… 

 
Click on B36 and type 
=MIN(B9,B14,B19,B24) 

 
Press  to complete the 

formula 

 

For Your Reference… 

To insert a minimum function: 

1. Click in the cell then click on the Insert 

Function tool   

2. Click on MIN in Select a function 

3. Insert the required ranges then click on 

[OK] 

Handy to Know… 

 You might use a Minimum function in real 
life to find the lowest value in a large range of 
numbers. For example, in a large inventory it 
can be used to work out which product is the 
slowest seller. 

4 

6 

7 
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COMMON ERROR MESSAGES 
 

 

 

 

  

 

 

Microsoft Excel has some in-built messages that 
can assist you when something goes wrong with 
a formula. These messages appear in the cell 
that contains the formula, and sometimes also 

other formula cells that depend upon it. The 
messages are always prefixed with a hash sign (#) 
and appear with a code. The more common error 
messages are listed below. 

A Line of Hash (#) Signs 

Sometimes referred to as “tramlines”, a line of hash 
signs usually occurs because a column is not wide 
enough to display the numbers in the cell or 
formula. Widening the column will correct this 
problem – you can drag the column heading until 
the value in the cell appears as it should. 

#DIV/0! 

This message means you are trying to divide a value by 
zero – this is mathematically impossible. In the example 
at the left we are trying to find the average number of 
persons per household. All is fine as long as there is a 
value greater than zero in cell B3 (Houses). As soon as 
we change this to a zero an error message appears in 
the formula cell (B5). 

To prevent the error you will need to enter a value 
greater than zero into cell B3, the divisor cell. 

#VALUE! 

In this message Excel is advising that something in the 
formula is not a value and therefore a calculation can’t be 
made. 

A close examination of the example at the left shows cell 
B3 contains the word “three”. Therefore the formula in 
cell B5 is trying to divide 192,664 (in cell B2) with a word, 
which doesn’t make sense. 

To fix the error, a value (a number) will need to be 
entered in cell B3. 

#NAME? 

This message appears when text is found in a 
formula that can’t be matched to either a 
legitimate function or range name. 

In the example to the left, the formula has been 
entered as =SOME(B3:B7) – there is no such 
function as SOME, and presumably the author 
should have typed =SUM(B3:B7). 
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PRACTICE EXERCISE 

Formulas And Functions 

Tasks: Completed: 

 Before starting this exercise you MUST have completed all of the topics in 
the chapter Formulas And Functions… 

 

 
Open the workbook called PE_Formulas And Functions.xlsx (it can be 
found in the same folder as the student files) 

 

 
Create a formula that calculates the gross pay for each employee, then use 
a function to calculate the total of the gross pay 

The total for Gross Pay should appear in E14... 

 

 
Create a formula that calculates the tax as being 20% of the gross pay for 
each employee, then create a total for the tax 

 

 
Create a formula to calculate the net pay for each employee and then a 
total of the net pay 

 

 
Create a formula that calculates the superannuation as being 8% of the 
gross pay for each employee, then create a total for superannuation 

 

 
Use functions to determine the average, maximum and minimum values for 
each column, setting the number of decimal places to 2 

Your worksheet should appear as shown on the following page... 

 

 
Use the Save As command to save the workbook as PE_Formulas And 
Functions (Completed).xlsx  

 

 



Microsoft Excel 

ITTraining@sgul.ac.uk Page 32 St. George’s Information Services 

UNDERSTANDING QUICK ANALYSIS 
 

 

 

 

  

 

The Quick Analysis tools were developed in 
response to the fact that users weren’t using or 
even aware of the more powerful analytical tools 
found in Excel. So Excel decided to combine 

Live Preview with some of these tools to create 
the Quick Analysis tools. 

The Quick Analysis Button 

The Quick Analysis button 
appears when a range is 
selected in a worksheet. 
Clicking on the button displays 
the Quick Analysis gallery 
which contains quick analysis 
tools that can be applied to the 
selected data. 

The tools have been organised 
along tabs at the top – 
FORMATTING, CHARTS, 
TOTALS, TABLES, and 
SPARKLINES. 

When you click on a tab, 
options specific to that tab are 
presented. 

Using Quick Analysis Tools With Live 
Preview 

Most of the Quick Analysis tools in the 
Quick Analysis gallery provide a Live 
Preview of the changes in the worksheet 
when you point to an option. 

This is very useful if you are not sure of the 
formatting or type of analysis you require as it 
provides you with a preview of what the data 
would look like if you selected that specific 
option. 

At the right we have selected only the totals 
from the worksheet shown above. We have 
pointed to options from the TOTALS tab (% 
Total and Average) and from the 
FORMATTING tab (Data Bars). 

Live Preview has either presented another 
row of analysed data or has formatted the 
selection accordingly. 

All of these tools are also available on the 
ribbon but using the Quick Analysis tools is 
much quicker. 
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QUICK FORMATTING 
 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST open 
the file E1355 Quick 
Analysis_1.xlsx… 

 
Click in cell B5, hold 
down , then click in 

cell E9 to select the range 
B5:E9 

 
Point to the bottom of the 
selected range so that the 
Quick Analysis button 
appears, as shown, then 
click on it to see the 
Quick Analysis gallery 

 
On the FORMATTING 
tab, point to Data Bars to 
see data bars 
representing the size of 
the selected values 

 
Point to Colour Scale to 
see colours used to 
signify the scale of values 
(from red for low to green 
for high) 

 
Point to Top 10% to see 
the top 10% of values 

 
Click on Greater Than to 
see the Greater Than 
dialog box 

 
Type 200000 in Format 
cells that are GREATER 
THAN, then click in cell 
A1 to see the changes 

 

The first tab in the Quick Analysis gallery is 
FORMATTING. This tab provides access to the 
conditional formatting tools of Excel. These are 
the tools that allow you to analyse data by 

colouring it or presenting it in a slightly different 
way. In the Quick Analysis gallery you can apply 
data bars, colour high and low values, values over 
or below a value, and more. 

2 

3 

6 

For Your Reference… 

To apply Quick Formatting in a worksheet: 

1. Select the range to be formatted, then click 
on the Quick Analysis button 

2. Choose the desired formatting from the 
FORMATTING tab 

Handy to Know… 

 Quick Formatting applies conditional 
formatting, not the standard formatting. 

 The Clear Format option in the Quick 
Analysis gallery will clear any conditional 
formatting that has been applied. 
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QUICK CHARTING 
 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
E1355 Quick 
Analysis_2.xlsx... 

 
Click in cell A3, hold 
down , then click in 

cell E9 to select the 
range A3:E9 

 
Click on the Quick 
Analysis button, then 
click on the CHARTS tab 
to see a range of 
recommended chart 
types for this range 

 
Point to Clustered 
Column to see a Live 
Preview of the chart with 
the Week as the legend 

 
Point to Line, then 
Stacked Area, then 
Stacked Column to see 
how these options appear 
in Live Preview  

 
Point to the second 
Clustered Column to 
see a preview of the chart 
with the Days as the 
legend 

 
Click on the second 
Clustered Column to 
create a chart in the 
worksheet 

 

Charts aren’t all that difficult to create in Excel, 
especially with the Recommended Charts 
feature. However, deciding what style and type of 
chart can be daunting. Fortunately the Charts 

tools provide a way of seeing what the different 
charts will look like without having to first create the 
chart. 

3 

6 

For Your Reference… 

To use the Quick Charting tools: 

1. Select the range to be charted, then click on 
the Quick Analysis button  

2. Choose the desired option from the 
CHARTS tab 

Handy to Know… 

 When creating a chart you’ll need to ensure 
that the range you select includes the labels 
to be used on the chart.  
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QUICK TOTALS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The TOTALS tab in the Quick Analysis gallery 
has some useful tools and options to help you 
build your worksheet. You can use the options to 
analyse data and perform alternate arithmetic 

operations (e.g. AVERAGE instead of SUM) or use 
the options to create the totals and calculations in 
the first place.   

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST 
open the file E1355 
Quick Analysis_3.xlsx… 

 
Click in cell B5, hold 
down , then click in 

cell E9 to select the 
range B5:E9 

 
Click on the Quick 
Analysis button, then 
click on the TOTALS tab 
to see the calculation 
options for this range 

 
Point to Vertical Sum to 
see a preview of the 
totals for each column 

 
Point to Horizontal 
Sum to see a preview of 
the totals for each row 

 
Point to the other 
options and study the 
results – do not click on 
any at this stage 

 
Click on Vertical Sum 
to create column totals 

 
Click on the Quick 
Analysis button again, 
click on the TOTALS 
tab, then click on 
Horizontal % to see the 
percentages for each 
day of the week 

 

3 

6 

For Your Reference… 

To create Quick Totals in a worksheet: 

1. Select the range to be totalled/calculated and 
click on the Quick Analysis button 

2. Choose the desired calculation methodology 
from the TOTALS tab 

7 

Handy to Know… 

 Always check any operation that performs 
calculations and embeds formulas for you to 
ensure that the correct cells and ranges are 
included in totals. 
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QUICK SPARKLINES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sparklines are mini charts that are embedded 
into a worksheet, usually immediately adjacent to 
the data. Sparklines are only relatively new in 
Excel and probably haven’t gained the 

acceptance or understanding that Microsoft would 
like. So, you’ll now find them in the Quick Analysis 
tools where you can easily implement them without 
too much head scratching. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST open 
the file E1355 Quick 
Analysis_4.xlsx… 

 
Click in cell B5, hold down 

, then click in cell E9 

to select the range B5:E9 

 
Click on the Quick 
Analysis button, then 
click on the 
SPARKLINES tab  

 
Point to Line to display a 
line drawing showing 
trends for each row 
across the four weeks 

 
Point to Column to 
display the trend as 
columns rather than a 
continuous line 

 
Click on Column to add 
Sparklines in column F 

Notice that after the 
Sparklines have been 
created the SPARKLINE 
TOOLS tab on the ribbon 
is now available so that 
you can further enhance 
or modify the Sparklines 

 

3 

5 

For Your Reference… 

To use Quick Sparklines in a worksheet: 

1. Select the range to be analysed, then click 
on the Quick Analysis button 

2. Choose the desired Sparkline from the 
SPARKLINES tab 

Handy to Know… 

 The Win/Loss is a special type of Sparkline 
that shows positives above an imaginary line 
and negatives below it. You need to have 
values range from the negative to the 
positive to make any good use of it. 
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QUICK TABLES 
 

 

 

 

 

 

 

 

                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                       

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In computer terminology a table is created when 
data is organised into rows and columns. You’d 
think then that a worksheet would be a table – 
but it is not in the Excel definition. In Excel a table 

does have columns and rows of continuous data. 
But it must also have headings which provide filter 
buttons. Creating a table is not hard, but it is much 
easier using Quick Tables. 

Try This Yourself: 

O
p

e
n

 F
il

e
 Before starting this 

exercise you MUST 
open the file E1355 
Quick 
Analysis_5.xlsx… 

 
Click in any cell 
containing data  

 
Hold down  + , 

then press  to select 

all of the non-empty 
cells around the current 
cell 

 
Using the scroll bars, 
scroll to the bottom 
right corner of the 
selection, click on the 
Quick Analysis button, 
then click on the 
TABLES tab 

 
Click on Table to turn 
the selected range into 
a table 

 
Scroll across and on 
the drop arrow for 
Position to see sorting 
and filtering options 

 
Click on Select All to 
remove the tick, then 
click on Effective 
People Leader so it 
appears ticked 

 
Click on [OK] to see 
only those people with 
this position title 

 

3 

For Your Reference… 

To use Quick Tables to create a table: 

1. Select the entire data to be used as a table 

2. Click on the Quick Analysis button 

3. Click on the TABLES table, then click on 
Table 

6 

7 

Handy to Know… 

 A drawback of using Quick Tables is that all 
of the data must be selected first. Using the 
normal operation to create a table (the Table 
command on the INSERT tab of the ribbon) 
only one cell in the table needs to be 
selected. 
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PRACTICE EXERCISE 

The Quick Analysis Tools 

Tasks: Completed: 

 Before starting this exercise you MUST have completed all of the topics in 
the chapter The Quick Analysis Tools… 

 

 
Open the workbook PE_Quick Analysis.xlsx (it can be found in the same 
folder as the student files) 

 

 
Use the Quick Analysis tools to apply a colour scale to the data in the 
worksheet 

 

 
Use the Quick Analysis tools to create a chart for the Overheads data. 
This chart should be a clustered column chart that has the column 
headings as the x axis, and displays the legend at the bottom of the chart. 
Make the chart title Cost of Overheads. 

 

 
Reposition the chart below the data  

 
Use the Quick Analysis tools to create Sparklines for the Qtr1 to Qtr4 
and Total columns for Overheads 

Your worksheet should appear as shown on the following page… 

 

 
Use the Save As command to save the workbook as PE_Quick Analysis 
(Completed).xlsx 

 
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PRINTING A WORKSHEET 
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Traditionally, printing means producing your 
document on paper, but in today’s Web and 
online world it might mean printing to the Web or 
to another file. Excel gives you a lot of control 

over what and how much to print, as well as 
enabling you to select the printer to use. You can 
print one or multiple copies of a document, one or 
multiple pages and even collate copies. 
 

Try This Yourself: 

 Continue using the previous 
file with this exercise... 

 Click on File Tab  then 
select Print to display the 
Print dialog box 

Your dialog box may appear a 
little different to the one 
shown, as the available 
options will depend on the 
make and model of printer that 
you are using... 

 
Click on Print to print the 
pages 

 

 
 

 
 

 

For Your Reference… 

To print a document: 

1. Click on the File Tab   
2. Click on Print 

 

Handy to Know… 

 You can also print a document directly, 
without opening the Print dialog box. Click 
the arrow on the Quick Access toolbar, 
Click Quick Print. This will send one copy of 
the document directly to the printer. 

1 

For Your Reference… 

To close a workbook: 

1. Click on the File Tab  and select Close 

Handy to Know… 

 If you save your workbook using the close 
command, the workbook will be closed 
without the prompting message above. 

 Excel allows you to have a number of 
workbooks open at the same time. When you 
close a workbook when others are still open 
one of the others will then appear. 

  
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THE CHARTING PROCESS 
 

 

 

 

  

 

Charts provide a way of seeing trends in the data 
in your worksheet. The charting feature in Excel 
is extremely flexible and powerful and allows you 
to create a wide range of charts from  

any of the Insert commands in the Charts group 
on the  

Inserting Charts 

The first step when creating a chart is to select the data from the worksheet that you want to chart. It is 
important to remember that the selected range (which can be either contiguous or non-contiguous), 
should include headings (e.g. names of months, countries, departments, etc). These become labels 
on the chart. Secondly, the selected range should not (normally) include totals as these are inserted 
automatically when a chart is created. 

The second step is to create a chart using the INSERT tab on the ribbon. You can choose a 
Recommended Chart where Excel analyses the selected data and suggests several possible chart 
layouts.  

Alternatively you can create the chart yourself from scratch by choosing one of the Insert commands 
in the Charts group. Charts that you create in Excel can be either embedded into a worksheet, or they 

can exist on their own sheets, known as chart sheets. 

Chart Sheets 

If you want to keep your 
chart separate from the data 
you can move the chart to 
its own sheet. Chart sheets 
make it easier and more 
convenient to work with your 
chart because you’ll see 
more of it on the screen – 
since the data is not there! 

Embedded Charts 

Charts that appear within a 
worksheet are known as 
embedded charts. A chart is 
really an object that sits on 
top of the worksheet – unlike 
numbers and letters, charts 
are not actually placed into 
worksheet cells. 
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CHOOSING THE RIGHT CHART 
 

 

 

 

  

 

Column, Bar 

 

 

These chart types, either in 2D or 3D, are used to 
compare values across categories. For example, 
they could compare the populations of different 
countries. 

Line, Area 

 

 

Lines in 2D or 3D are useful for showing trends 
such as sales or employment figures. An area 
chart is a line chart with the area below the line 
filled in. 

Surface 

 

The surface chart plots trends in two dimensions. 
You could use this to plot departmental sales 
figures over time. The chart then shows you the 
trends between departments, as well as the sales 
trends over time. 

Pie, Doughnut 

 

If you want to show proportion, such as the sales 
figures from different departments that make up a 
total, then the pie and doughnut charts are for 
you. The only variation between the doughnut 
chart and the pie chart is that the doughnut chart 
can display more than one series of values. 

Stock 

 

The stock chart type has been designed to show 
the stock figures for a day, and the trend over 
time. At its simplest, you can plot the high, low 
and close figures, and at its most complex, the 
volume, open, high, low, and close. It can be 
adapted to show the relationships between any 
five sets of values. 

XY (Scatter) 

 

Scatter diagrams are used to display the 
relationship between two variables. For example, 
you could research the age and price of a series 
of cars, and plot the values you find. You could 
also investigate the height and weight 
relationship of a group of people. 

Radar 

 

A radar diagram is designed to show the change 
in values from a central point. For example, it can 
be used to show mobile telephone coverage, 
including multiple networks and multiple 
measurements. 

 

A chart is far more effective at communicating 
results, outcomes or trends than a table of figures 
displaying the same information. Different chart 
types have been created to  

communicate different types of information. Some 
charts show simple relationships between values, 
while others are designed for quite technical 
purposes. Here is a summary of the use of different 
chart types. 
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USING A RECOMMENDED CHART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you are undecided about the best type of chart 
for the data you have selected to graph, then you 
may wish to use Excel’s Recommended Charts 
feature. This feature analyses your  

selected data and presents you with what it 
considers to be the best way to chart that data. 
Several alternatives are presented and you simply 
choose the one you like most. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file 
E1317 Charting_1.xlsx… 

 
Click in cell A3, hold down 

, then click in cell G7 to 
select the range A3:G7 

 
Click on the INSERT tab, 
then click on 
Recommended Charts in 
the Charts group 

The Insert Chart dialog box 
will display with a number 
of recommended chart 
options… 

 
Click on each of the 
alternatives in the left pane 
to see a preview of how the 
chart will appear in the right 
pane and spend a few 
moments reading the 
descriptions 

 
Click on Line chart (the 
second alternative in the 
left pane), then click on 
[OK] to embed the chart in 
the worksheet 

 
Point to the top border of 
the chart, then click and 
drag the chart immediately 
below the data 

 
Click in cell A1 to deselect 
the chart 

 

1 You can also use the Quick Analysis tool that appears at the 
bottom right corner of a selected range to create a quick chart. 
However, this method will not allow you to preview a wide 
variety of charts. 

2 

For Your Reference… 

To use the Recommended Charts feature: 

1. Select the data to be charted 

2. Click on the INSERT tab, then click on 
Recommended Charts in the Charts group 

3. Click on the desired chart and click on [OK] 

Handy to Know… 

 When selecting data for a chart you should 
include headings (e.g. names of the month, 
regions, etc.) but not the totals derived from 
the data. In the example above the names of 
the months and the cities are selected but 
the total revenue and the regional totals are 
not. 
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CREATING A NEW CHART FROM SCRATCH 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST open 
the file E1317 
Charting_1.xlsx… 

 
Click in cell A3, hold down 

, then click in cell G7 
to select the range A3:G7 

Note that we have 
selected the data 
including headings but 
excluding the totalling… 

 
Click on the INSERT tab, 
then click on Insert 
Column Chart in the 
Charts group to see a 
gallery of Column chart 
types 

 
Under 2-D Column, click 
on Clustered Column  

The chart will be 
embedded in the 
worksheet. The chart will 
be active (selected) and 
you’ll see additional tabs 
on the ribbon for working 
with the chart… 

 
Point to the chart, then 
click to select it and drag 
the chart so that it is 
underneath the data, as 
shown 

 
Click in cell A1 to deselect 
the chart 

 

2 

For Your Reference… 

To create a chart from scratch: 

1. Select the range to chart 

2. Click on the INSERT tab, then click on the 
appropriate Insert command in the Charts 
group 

3. Click on the desired chart type 

The easiest way to create a chart is by using the 
Recommended Chart feature. However, you 
can create a chart yourself from scratch using 

INSERT tab of the ribbon. This may be faster if you 
have a specific style of chart in mind. 

Handy to Know… 

 When a chart gallery appears after you’ve 
used the Insert chart command, you can 
point over each image in the gallery to see a 
Live Preview of the chart in the worksheet. 
This will help you to select the right chart for 
your needs. 

4 
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WORKING WITH AN EMBEDDED CHART 
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Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
E1317 Charting_2.xlsx... 

 
Point to the border of the 
chart and click once to 
select the chart as an 
object 

The border of the chart will 
thicken to indicate that the 
chart is selected, the 
range of data used for the 
chart will be coloured, the 
ribbon will show  
chart-specific tabs and 
commands, and additional 
tools will appear to the 
right of the chart… 

 
Click on the chart legend 
to make it the active object 
in the chart 

 
Click on the vertical axis 
to make it the active object 

 
Click on the horizontal 
axis to make it the active 
object 

 
Click on the border of the 
chart to make the overall 
chart the active object 
again – notice that the 
range of data has been 
coloured again  

 
Click in cell A1 to deselect 
the chart 

 

By default, new charts are placed in the active 
worksheet, which is usually the one that contains 
the data. Charts are placed over the top of the 
worksheet, embedded as objects. When you  

want to work with a chart you must select it – this 
can be done by clicking on the chart. The chart 
itself is made up of many objects and these too can 
be selected by clicking on them. 

For Your Reference… 

To select a chart and its objects: 

1. Click on the border of the chart to select an 
embedded chart 

2. Click on the various objects of a chart to 
select them 

Handy to Know… 

 Once an object is selected, be it a chart, a 
legend on the chart, or the like, you can right-
click on the object to see a shortcut menu 
specific to the selected object. 

3 
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RESIZING A CHART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the 
file E1317 
Charting_3.xlsx... 

 
Click on the chart to 
select it 

 
Point to the sizing 
handle on the left 
border of the chart until 
the mouse pointer 
changes to a double 
arrow 

 
Hold down the left 
mouse button and drag 
left until the chart 
appears as shown 

You can also resize a 
chart from the ribbon… 

 
Click on the CHART 
TOOLS: FORMAT tab  

 
Click on the up spinner 
arrow for Shape 
Height in the Size 
group until it shows 8.5 
cm 

 
Click on the up spinner 
arrow for Shape Width 
in the Size group until it 
shows 17 cm 

 
Click in cell A1 to 
deselect the chart 

 

3 

For Your Reference… 

To resize a chart: 

1. Select the chart, then click on and drag a 
sizing handle on the border of the chart, or 

 Click on the CHART TOOLS: FORMAT tab, 
then click on up/down spinner arrows for 
Shape Height and Shape Width in the Size 
group  

There are two main ways to resize a chart if you 
are not satisfied with its current size. A chart that 
has been selected can be resized by dragging 
one of the sizing handles around its border.  

These handles appear with dots in them. You can 
also resize a chart using commands in the Size 
group on the CHART TOOLS: FORMAT tab that 
appears when the chart is selected. 

4 

Handy to Know… 

 If you wish to change the size of a chart 
quickly and easily, clicking on and dragging 
the resize handles is the best option whereas 
if you want to resize a chart to a specific size 
it is best to resize the chart using the tools in 
the Size group on the CHART TOOLS: 
FORMAT tab. 
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REPOSITIONING A CHART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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 Continue using the 

previous file with this 
exercise, or open the 
file E1317 
Charting_4.xlsx... 

 
Click on the chart to 
select it 

 
Point to the border of 
the chart until the 
mouse pointer 
changes to a four-
headed arrow 

 
Hold down the left 
mouse button and 
drag the chart below 
the data so that the 
Total Revenue row 
in the worksheet is 
visible 

 
Click in cell A1 to 
deselect the chart 

 

2 

It’s unlikely that a chart embedded in the 
worksheet by Excel will be exactly where you 
would like it to be. You can easily relocate a chart 
to a more appropriate position by clicking  

on and dragging the border of the chart to the 
desired location. The chart obviously must be 
selected before it can be dragged to a new 
position. 

For Your Reference… 

To move a chart: 

1. Click on the chart to select it 

2. Move the mouse pointer to the border of the 
chart until the mouse pointer changes to a 
four-headed arrow 

3. Drag the chart to a new location 

Handy to Know… 

 You can use the standard cut and paste 
commands to move a chart. Select the chart, 
click on the HOME tab, then click on Cut in 
the Clipboard group to copy it to the 
clipboard. Click in a new location and, on the 
HOME tab, click on Paste in the Clipboard 
group to paste the chart. 

3 
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PRINTING AN EMBEDDED CHART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Before starting this 
exercise you MUST 
open the file E1317 
Charting_5.xlsx… 

 
Click on the FILE 
tab, then click on 
Print to see a 
preview of the data 
and the chart 

Not all of the chart or 
data may be visible 
so we’ll change the 
orientation to 
landscape… 

 
Click on Portrait 
Orientation in 
Settings then select 
Landscape 
Orientation 

 
Click on [Print] to 
print the chart 

If you don’t have a 
printer connected or 
you don’t wish to 
print, click on the 
Back arrow to 
display the workbook 
again 

 

1 

When you print a worksheet, Excel will print 
whatever is in or embedded in that worksheet 
(including charts). This makes it easy and 
convenient to print both the chart and its  

underlying data. All you need to do is to position 
the chart in the appropriate location then access 
the print commands in the usual way. 

2 

For Your Reference… 

To print an embedded chart: 

1. Click on the FILE tab, then click on Print 

2. Click on [Print] 

Handy to Know… 

 If you only want to print the chart and not the 
data, click on the chart to select it, click on 
the FILE tab, then click on Print. You will 
notice that only the chart will appear in the 
preview. 
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CREATING A CHART SHEET 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Charts can either be stored in a worksheet or in a 
separate sheet of their own known as a chart 
sheet. Chart sheets separate the chart from the 
underlying data and are useful especially if you  

are interested in printing the chart on its own page. 
Charts can be shifted back and forth between a 
worksheet and a chart sheet. 

Try This Yourself: 

S
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e
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Continue using the 
previous file with this 
exercise, or open the file 
E1317 Charting_6.xlsx... 

 
Click on the chart to 
select it and display the 
CHART TOOLS:DESIGN 
and CHART TOOLS: 
FORMAT tabs  

 
Click on the CHART 
TOOLS: DESIGN tab, 
then click on Move Chart 
in the Location group to 
display the Move Chart 
dialog box 

 
Click on New Sheet, then 
type Revenue Chart  

This will become the 
sheet name for the 
chart… 

 
Click on [OK] to move the 
embedded chart to its 
own sheet 

 
Click on the Chart Data 
worksheet tab to see the 
data again 

Notice that the chart is no 
longer embedded on this 
worksheet 

 

2 

3 

4 

For Your Reference… 

To create a chart sheet: 

1. Click on the CHART TOOLS: DESIGN tab, 
then click on Move Chart in the Location 
group 

2. Click on New Sheet, type a name for the 

sheet and click on [OK] 

Handy to Know… 

 Keeping charts on their own sheets makes 
them easier to work with as they do not 
obstruct the data.  
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CHANGING THE CHART TYPE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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e
 Continue using the 

previous file with this 
exercise, or open the 
file E1317 
Charting_7.xlsx... 

 
Click on the Revenue 
Chart worksheet tab to 
see the chart, then click 
anywhere on the chart 
to select it and display 
the chart commands on 
the ribbon 

 
Click on the CHART 
TOOLS: DESIGN tab, 
then click on Change 
Chart Type in the Type 
group to display the 
Change Chart Type 
dialog box 

 
Click on 3-D Column, 
as shown 

 
Click on [OK] to apply 
the change to the chart 

 
Click on the Chart Data 
worksheet tab to return 
to the worksheet 

 

3 

When you create a chart, you may not always 
achieve the result that you desire. Fortunately, 
the process for changing a chart type is quite 
simple. You just need to have an understanding  

of what each chart type is designed for and to 
select the format that best suits your purpose. Just 
be aware that some chart types are designed for 
specialised applications. 

For Your Reference… 

To change the chart type: 

1. Ensure the chart or chart sheet is selected 

2. Click on the CHART TOOLS: DESIGN tab, 
then click on Change Chart Type in the 
Type group 

3. Click on the desired chart and click on [OK] 

Handy to Know… 

 You can use Change Chart Type in the 
Type group on the CHART TOOLS: 
DESIGN tab for either embedded charts or 
charts that have their own worksheet tabs. 

4 
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CHANGING THE CHART LAYOUT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
E1317 Charting_8.xlsx... 

 
Click on the Revenue 
Chart worksheet tab to 
see the chart, then click 
anywhere on the chart to 
select it and see the 
CHART TOOLS: 
DESIGN and CHART 
TOOLS: FORMAT tabs 

 
Click on the CHART 
TOOLS: DESIGN tab, 
then click on Quick 
Layout in the Chart 
Layouts group to display 
a gallery of layout 
options 

 
Click on Layout 3 to 
apply this chart layout to 
the chart 

 
Repeat steps 2 and 3 to 
select other chart 
layouts and see how 
they appear when 
applied to the chart 

 
Click on Quick Layout in 
the Chart Layouts group 
and click on Layout 5 

 
Click on the Chart Data  
worksheet tab to display 
this worksheet 

 

2 

Excel has a gallery of chart layouts that can be 
applied to an existing and selected chart that is 
either in its own worksheet or embedded into the 

data worksheet. Chart layouts are the way  

elements of the chart are placed within the chart. 
Different layout options can therefore change the 
appearance of your chart and its readability.  

For Your Reference… 

To change the chart layout: 

1. Ensure the chart or chart sheet is selected 

2. Click on the CHART TOOLS: DESIGN tab, 
then click on Quick Layout in the Chart 
Layouts group 

3. Select the desired layout 

Handy to Know… 

 Chart layouts are predefined themes 
created by Microsoft. Even if you choose one 
of these layouts you can still make your own 
modifications to the way the elements and 
objects are positioned and how they appear. 

5 
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CHANGING THE CHART STYLE 
 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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 Continue using the 

previous file with this 
exercise, or open the 
file E1317 
Charting_9.xlsx... 

 
Click on the Revenue 
Chart worksheet tab to 
see the chart, then click 
anywhere on the chart 
to select it  

 
Click on the Chart 
Styles tool to the right 
of the chart to see a 
gallery of style options, 
as shown 

 
Scroll through the 
gallery and point to 
each style to see how 
your chart will look in 
Live Preview 

 
Scroll to and click on 
Style 9 

 
Click on the Chart 
Styles tool to the right 
of the chart to close the 
gallery 

 
Click on the Chart Data 
worksheet tab 

 

2 

The style of a chart refers to its colour scheme 
and overall appearance and can impact the 
clarity of the content of the chart.  Choosing a 
predefined chart style can save valuable time  

and effort. Excel also makes it easy to change 
chart styles if you decide the style you have chosen 
is not appropriate. 
 
 

For Your Reference… 

To change the chart style: 

1. Ensure the chart or chart sheet is selected 

2. Click on the Chart Styles tool to the right of 
the chart 

3. Click on the desired style 

Handy to Know… 

 Instead of using the Chart Styles tool to the 
right of the chart, you can also choose chart 
styles from the CHART TOOLS: DESIGN 
tab on the ribbon when a chart is selected.  

4 
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PRINTING A CHART SHEET 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file E1317 
Charting_10.xlsx... 

 
Click on the Revenue Chart 
worksheet tab 

 
Click on the Chart Title text 
box, select the text, then 
type Revenue Chart to 
change the title 

 
Repeat step 2 to change the 
Axis Title to Euros  

 
Click on the FILE tab, then 
click on Print to see the 
print options and a preview 
of the chart 

No further adjustment is 
required here so we can go 
ahead and print it… 

 
If you wish to print the chart, 
click on [Print] 

If you don’t have a printer 
connected or wish to save 
paper, click on the Back 
arrow to return to the 
worksheet… 

 
Click on the Chart Data 
worksheet tab 

 

2 

For Your Reference… 

To print a chart sheet: 

1. Click on the chart sheet tab 

2. Click on the FILE tab, then click on Print 

3. Click on [Print] 

You can print an embedded chart simply by 
printing the worksheet as if it is a standard 
worksheet. You can also print a chart sheet in 
exactly the same way. To print a chart sheet, the 
worksheet data. But the real benefit of inserting 

simply ensure that the chart sheet is active, then 
click on the FILE tab, click on Print, apply the print 

settings as desired and click on [Print].  

Handy to Know… 

 When you preview a chart prior to printing, it 
may not appear as clearly as you would like. 
This is due to the screen resolution, not the 
chart itself. The printed version of the chart 
will appear clearer than the preview. 

4 
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EMBEDDING A CHART INTO A WORKSHEET 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the 
file E1317 
Charting_11.xlsx... 

 
Click on the Revenue 
Chart worksheet tab 

 
Click on the CHART 
TOOLS: DESIGN tab, 
then click on the Move 
Chart tool in the 
Location group to 
display the Move Chart 
dialog box 

 
Click on Object in, then 
click on the drop arrow 
and click on Sheet 2 

 
Click on [OK] to move 
the chart to the 
worksheet 

 
Reposition the chart by 
dragging it to the top 
left of the sheet, then 
drag the resizing 
handles to resize it as 
shown 

 
Click on the Chart Data 
worksheet tab 

 

Charts can either be presented in their own 
sheets or they can be embedded into a 
worksheet that contains data. In fact, you can 
move a chart back and forth between its own  

sheet and a worksheet as often as you wish without 
impacting at all on the chart. Sometimes it is easier 
to work with a chart in its own sheet, but it may be 
necessary to print the chart with its data. 

3 

4 

For Your Reference… 

To embed a chart in a worksheet: 

1. Click on the CHART TOOLS: DESIGN tab, 
then click on Move Chart in the Location 
group 

2. Click on the drop arrow, select the sheet to 

embed it into, then click on [OK] 

5 

Handy to Know… 

 Embedding is normally only done when it is 
necessary to print the worksheet and the 
data together. 
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DELETING A CHART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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e
 Continue using the 

previous file with this 
exercise, or open the 
file E1317 
Charting_12.xlsx... 

 
Click on Sheet 2 to 
see the chart in the 
worksheet, then click 
on the chart to select it 

 
Press  to delete 
the chart 

 

1 

For Your Reference… 

To delete a chart: 

1. Click on the worksheet to see the chart, then 
click on the chart to select it 

2.  Press  

If you no longer require a chart you can easily 
delete it. With embedded charts you must first 
select the chart in the worksheet and then press 

the  key to delete the chart. With charts in  

chart sheets you can delete the sheet by right 
clicking on the chart sheet tab and choosing the 
deletion option. 

2 

Handy to Know… 

 Because it is so easy to delete a chart object 
it is also easy to delete it by accident! 
Remember, you can use the Undo feature in 
Excel to restore accidental deletions. 
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PRACTICE EXERCISE 

Creating Charts 
 

 

Tasks: Completed: 

 Before starting this exercise you MUST have completed all of the topics in 
the chapter Creating Charts… 

 

 
Open the workbook called PE_Creating Charts.xlsx (it can be found in the 
same folder as the student files) 

 

 
Create a Clustered Column chart showing the sales of products for the 
months of January through to June 

 

 
Drag the chart down below the data and resize it so that it is the same 
width as the data, keeping the proportions as far as possible 

 

 
Change the chart type to 3-D Stacked Column and change the chart title 
to Sales 

The chart should appear as shown in sample A on the following page... 

 

 
Create a Pie in 3-D chart of the products and their totals then place it on its 
own chart sheet called Product Sales 

 

 
Change the Chart Title to Product Sales  

 
Change the layout to Layout 6  

The chart should appear as shown in sample B on the following page... 

 

 
Print the pie chart  

 
Use the Save As command to save the workbook as PE_Creating Charts 
(Completed).xlsx 

 

 

Files required for 
exercise: 

PE_Creating Charts.xlsx 

Files/work created by 
student: 

PE_Creating Charts (Completed).xlsx, 1 printed copy of the Product Sales 
chart 

Exercise Completed:  
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PRACTICE EXERCISE SAMPLE 

Creating Charts 
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Introduction 

In this introductory course to Excel, participants will explore Excel activities that go beyond the basic.  After 

successful completion of this session, participants can expect to have the skills required to work efficiently 

in an existing worksheet and to also create new worksheets from a template and from scratch. 

Topics Include  

 Create a basic worksheet by entering text, values, and formulas. 

 Change the appearance of worksheet data by using a variety of formatting techniques. 

 Create formulas by using some of Excel's built-in functions. 

 Filter and sort Excel data. 

 Plan, create and modify charts. 

 Prepare a document for printing by using a variety of printing options. 

Prerequisite 

Comfortable with Windows 7, or OSX 

Platform 

Windows, OSX 

Software 

Microsoft Excel 2013, Microsoft Excel 2010 (Windows) 

Microsoft Excel 2011 (MAC) 

Instructor  

Anna Neagu – Application Support Consultant 
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1. Opening Excel 

Using Windows 7 

1. Click on the Start Button.  

2. In the Search Program and Files box type Excel. 

3. Click on Excel 2013 from the Program results. 

4. The Microsoft Excel 2013 program will open. 

 

Using Windows 8  

1. Press the Windows key on the keyboard.  

2. Type Excel. 

3. Click on Excel 2013 under the Apps results.  

 

Using iOS 7 

1. Click on Launchpad. 

2. Select Microsoft Excel. 

 

2. Getting Started  

When you open Excel 2013 for the first time, the Excel Start Screen will appear. From here, you'll be able 

to create a new workbook, choose a template, and access your recently edited workbooks. 

1. From the Excel Start Screen, locate and select Blank workbook to access the Excel interface. 

2. Click Open Other Workbooks to work on an existing workbook.  
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To set up Excel so it automatically opens a new workbook  

1. Click File then Options.  

2. On the General tab, under Start up options, uncheck the Show the Start screen when this 

application starts box.  

3. The next time you start Excel, it opens a blank workbook automatically similar to older versions of 

Excel. 

2.1. The Excel Interface 

After starting Excel, you will see two windows - one within the other. The outer window is the Application 

Window and the inner window is the Workbook Window. When maximized, the Excel Workbook Window 

blends in with the Application Window. 

 After completing this module, you should be able to: 

 Identify the components of the Application Window. 

 Identify the components of the Workbook Window. 

Open an existing workbook 

Create a new workbook 
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2.1.1. The Application Window 

The Application Window provides the space for your worksheets and workbook elements such as charts. 

The components of the Application Window are described below. 

 The Quick Access Toolbar 

The Quick Access Toolbar lets you access common commands no matter which tab is selected.  

By default, it includes the Save, Undo, and Repeat commands. You can add other commands depending 

on your preference. 

To add commands to the Quick Access toolbar 

1. Click the drop-down arrow to the right of the Quick Access toolbar. 

The Ribbon 

Command Group 

Name Box Formula Bar 

Cell 

Quick Access Toolbar 

Row 

Colum

n 

Worksheets 

Worksheet View Option Zoom Control 

Vertical and Horizontal Scroll Bars 
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2. Select the command you wish to add from the drop-down menu. To choose from more commands, 

select More Commands.  

 

 

 

 

 

 

 

 

 

 

 

3. The command will be added to the Quick Access toolbar. 

 

 

 

 The Ribbon 

Excel 2013 uses a tabbed Ribbon system instead of traditional menus. The Ribbon contains multiple tabs, 

each with several groups of commands. You will use these tabs to perform the most common tasks in 

Excel. 
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To minimize and maximize the Ribbon 

The Ribbon is designed to respond to your current task, but you can choose to minimize it if you find that 

it takes up too much screen space. 

1. Click the Ribbon Display Options arrow in the upper-right corner of the Ribbon. 

 

Each tab is divided 

into groups 

Click a tab to see 

more commands 
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2. Select the desired minimizing option from the drop-down menu: 

 Auto-hide Ribbon: Auto-hide displays your workbook in full-screen mode and completely hides the 

Ribbon. To show the Ribbon, click the Expand Ribbon command at the top of screen.  

 

 

 

 

 

 Show Tabs: This option hides all command groups when not in use, but tabs will remain visible. To 

show the Ribbon, simply click a tab. 

 Show Tabs and Commands: This option maximizes the Ribbon. All of the tabs and commands will 

be visible. This option is selected by default when you open Excel for the first time. 

To Customize the Ribbon in Excel 2013 

You can customize the Ribbon by creating your own tabs with whichever commands you want. Commands 

are always housed within a group, and you can create as many groups as you want in order to keep your 

tab organized. If you want, you can even add commands to any of the default tabs, as long as you create 

a custom group in the tab. 

1. Right-click the Ribbon and then select Customize the Ribbon... from the drop-down menu. 

 

 

 

 

 

2. The Excel Options dialog box will appear. Locate and select New Tab. 

Click the Expand Ribbon 

command to show the Ribbon 

Ribbon is hidden and workbook 

appears in full screen 
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3. Make sure the New Group is selected, select a command, and then click Add. You can also drag 

commands directly into a group.  

4. When you are done adding commands, click OK. The commands will be added to the Ribbon. 

 

 

 

 

 

 

 

 

 

 

 

Select 

commands and 

click Add 
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 The Formula Bar 

In the formula bar, you can enter or edit data, a formula, or a function that will appear in a specific cell.  

In the image below, cell C1 is selected and 1984 is entered into the formula bar. Note how the data 

appears in both the formula bar and in cell C1. 

 

 

 

 

 The Name Box 

The Name box displays the location, or "name" of a selected cell.  

In the image below, cell B4 is selected. Note that cell B4 is where column B and row 4 intersect. 

 

 The Backstage View (The File Menu) 

Click the File tab on the Ribbon. Backstage view will appear.  
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 The Worksheet Views 

Excel 2013 has a variety of viewing options that change how your workbook is displayed. You can choose 

to view any workbook in Normal view, Page Layout view, or Page Break view. These views can be useful 

for various tasks, especially if you're planning to print the spreadsheet. 

To change worksheet views, locate and select the desired worksheet view command in the bottom-right 

corner of the Excel window. 

 

Return to Excel 
Info contains 

information about the 
current workbook. You 

can also inspect the 
workbook and set 

protection controls. 
New: you can create a new, blank 
workbook, or choose from a large 

selection of templates. 

Open: you can open 
recent workbooks, as 

well as workbooks saved 
to your OneDrive or on 

your computer. 

From the Print pane, 

you can change the 

print settings and print 

your workbook. You 

can also see a preview 

of your workbook. 

Use Save and Save As to save 
your workbook to your computer 

or to Office 365. 

Share: you can invite people to view and 

collaborate on your workbook. You can also share 

your workbook by emailing it as an attachment. 

Export: you can choose 
to export your 

workbook in another 
format, such as 

PDF/XPS or Excel 
1997-2003. 

Close the current workbook. 

From the Account pane, you can access your 
Microsoft account information, modify your theme 

and background, and sign out of your account. 

Options: you can change various Excel options. For 
example, you can control the Quick Analysis preferences, 

Auto Recover settings, or Language preferences. 
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 Zoom Control 

To use the Zoom control, click and drag the slider. The number to the right of the slider reflects the zoom 

percentage. 

 

Challenge! 

1. Open Excel 2013. 

2. Click through all of the tabs, and review the commands on the Ribbon. 

3. Try minimizing and maximizing the Ribbon. 

4. Add a command to the Quick Access toolbar. 

5. Navigate to Backstage view, and open your Account settings. 

6. Try switching worksheet views. 

7. Close Excel (you do not have to save the workbook). 

 

Normal View 

Page Layout 

View 

Page Break 

View 
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2.1.2. The Workbook Window 

In Excel 2013, when you open up a new workbook it now contains only 1 worksheet There can be a max 

of 1,048,576 rows and 16,384 columns in an excel work sheet. 

 The Worksheet 

Excel files are called workbooks. Each workbook holds one or more worksheets (also known as 

"spreadsheets"). 

Whenever you create a new Excel workbook, it will contain one worksheet named Sheet1. A worksheet is 

a grid of columns and rows where columns are designated by letters running across the top of the 

worksheet and rows are designated by numbers running down the left side of the worksheet. 

 

 

 

 

 

 

 

 

When working with a large amount of data, you can create multiple worksheets to help organize your 

workbook and make it easier to find content. You can also group worksheets to quickly add information 

to multiple worksheets at the same time. 

To rename a worksheet 

Whenever you create a new Excel workbook, it will contain one worksheet named Sheet1. You can rename 

a worksheet to better reflect its content. In our example, we will create a training log organized by month. 

1. Right-click the worksheet you wish to rename, then select Rename from the worksheet menu.  



  Excel Training - Level 1 

Page | 16  

 

2. Type the desired name for the worksheet.  

 

3. Click anywhere outside of the worksheet, or press Enter on your keyboard. The worksheet will be 

renamed.  

 

To insert a new worksheet 

1. Locate and select the New sheet button.  

 

 
Click to add a 

new worksheet 
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2. A new, blank worksheet will appear. 

 TIP: To change the default number of worksheets, navigate to Backstage view, click Options, and 

then choose the desired number of worksheets to include in each new workbook. 

 

 

 

 

 

 

 

 

 

To delete a worksheet 

1. Right-click the worksheet you wish to delete, then select Delete from the worksheet menu.  

 

2. The worksheet will be deleted from your workbook.  
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Alternatively, from the Home Tab in the Cells Group click on Delete and select Delete Sheet.  

Warning: The Undo button will not undo the deletion of a worksheet. 

To copy a worksheet 

If you need to duplicate the content of one worksheet to another, Excel allows you to copy an existing 

worksheet. 

1. Right-click the worksheet you want to copy, then select Move or Copy from the worksheet menu.  

 

 

 

 

 

 

 

 

2. The Move or Copy dialog box will appear. Choose where the sheet will appear in the Before sheet: 

field. In our example, we'll choose (move to end) to place the worksheet to the right of the existing 

worksheet.  

3. Check the box next to Create a copy, then click OK. 
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4. The worksheet will be copied. It will have the same title as the original worksheet, as well as a 

version number. 

TIP: You can also copy a worksheet to an entirely different workbook. You can select any workbook 

that is currently open from the To book: drop-down menu. 

 

 

 

 

 

 

 

To move a worksheet 

Sometimes you may want to move a worksheet to rearrange your workbook. 

1. Select the worksheet you wish to move. The cursor will become a small worksheet icon . 

2. Hold and drag the mouse until a small black arrow appears above the desired location.  
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3. Release the mouse. The worksheet will be moved. 

To change the worksheet color 

You can change a worksheet's color to help organize your worksheets and make your workbook easier to 

navigate. 

1. Right-click the desired worksheet, and hover the mouse over Tab Color. The Color menu will 

appear. 

2. Select the desired color. A live preview of the new worksheet color will appear as you hover the 

mouse over different options. In our example, we'll choose Red.  

 

 

 

 

 

 

 

 

3. The worksheet color will be changed. 



  Excel Training - Level 1 

Page | 21  

The worksheet color is considerably less noticeable when the worksheet is selected. Select another 

worksheet to see how the color will appear when the worksheet is not selected. 

 

 

 

 

Challenge! 

 

1. Open an existing Excel workbook.  

2. Insert a new worksheet and rename it.  

3. Delete a worksheet.  

4. Move a worksheet. 

5. Copy a worksheet. 

 

 

 The Scrolling Buttons 

These buttons scroll the display of sheet tabs one at a time or to display the first and last grouping of sheet 

tabs and are located to the left of the sheet tabs. 

 

 

 

 

 

 

 

Scroll between 

worksheets 
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 The Scroll Bars 

Your spreadsheet may frequently have more data than you can see on the screen at once. Click, hold 

and drag the vertical or horizontal scroll bar depending on what part of the page you want to see. 

 

 

 

 

 

 

 

 

2.2. Creating and Opening Workbooks 

Excel files are called workbooks. Whenever you start a new project in Excel, you'll need to create a new 

workbook. There are several ways to start working with a workbook in Excel 2013. You can choose to 

create a new workbook—either with a blank workbook or a predesigned template—or open an existing 

workbook. 

2.2.1. Create a new blank workbook 

1. Select the File tab. Backstage view will appear. 

 

        

 

 

 

 

Vertical 

scroll bar 

Horizontal 

scroll bar 
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2. Select New, then click Blank workbook. 

3. A new blank workbook will appear. 

2.2.2. Open an existing workbook 

In addition to creating new workbooks, you'll often need to open a workbook that was previously saved. 

1. Navigate to Backstage view, then click Open. 

 

 

 

 

 

 

 

 

 

2. Select Computer, and then click Browse.  
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3. The Open dialog box will appear. Locate and select your workbook, then click Open. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 TIP: If you've opened the desired workbook recently, you can browse your Recent Workbooks 

rather than searching for the file. 
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To pin a workbook 

If you frequently work with the same workbook, you can pin it to Backstage view for quick access. 

1. Navigate to Backstage view and then click Open. Your recently edited workbooks will appear. 

2. Hover the mouse over the workbook you wish to pin. A pushpin icon will appear next to the 

workbook. Click the pushpin icon. 

 

 

 

 

 

 

 

3. The workbook will stay in Recent Workbooks. To unpin a workbook, simply click the pushpin icon 

again. 

 

 TIP: You can also pin folders to Backstage view for quick access. From Backstage view, click Open, 

then locate the folder you wish to pin and click the pushpin icon. 

 

2.2.3. Compatibility mode 

Sometimes you may need to work with workbooks that were created in earlier versions of Microsoft Excel, 

such as Excel 2003 or Excel 2000. When you open these kinds of workbooks, they will appear in 

Compatibility mode. 
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Compatibility mode disables certain features, so you'll only be able to access commands found in the 

program that was used to create the workbook. For example, if you open a workbook created in Excel 

2003, you can only use tabs and commands found in Excel 2003. 

In order to exit Compatibility mode, you'll need to convert the workbook to the current version type. 

However, if you're collaborating with others who only have access to an earlier version of Excel, it's best 

to leave the workbook in Compatibility mode so the format will not change. 

To convert a workbook 

If you want access to all of the Excel 2013 features, you can convert the workbook to the 2013 file format. 

Note that converting a file may cause some changes to the original layout of the workbook. 

1. Click the File tab to access Backstage view. 

2. Locate and select Convert command.  

 

 

 

3. The Save As dialog box will appear. Select the location where you wish to save the workbook, 

enter a file name for the presentation, and click Save. 

4. The workbook will be converted to the newest file type. 

 

Challenge! 

1. Create a new blank workbook. 

2. Open an existing workbook from your computer. 

3. Pin a folder to Backstage view. 
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2.3. Saving and Sharing Workbooks 

 

Whenever you create a new workbook in Excel, you'll need to know how to save it in order to access and 

edit it later. As with previous versions of Excel, you can save files locally to your computer. But unlike older 

versions, Excel 2013 also lets you save a workbook to the cloud using OneDrive. You can also export and 

share workbooks with others directly from Excel. 

 

2.3.1. Save and Save As 

 

Excel offers two ways to save a file: Save and Save As. These options work in similar ways, with a few 

important differences: 

 Save: When you create or edit a workbook, you'll use the Save command to save your changes. 

You'll use this command most of the time. When you save a file, you'll only need to choose a file 

name and location the first time. After that, you can just click the Save command to save it with 

the same name and location. 

 Save As: You'll use this command to create a copy of a workbook while keeping the original. When 

you use Save As, you'll need to choose a different name and/or location for the copied version. 

 

To save a workbook 

 

It's important to save your workbook whenever you start a new project or make changes to an existing 

one. Saving early and often can prevent your work from being lost. You'll also need to pay close attention 

to where you save the workbook so it will be easy to find later. 

 

1. Locate and select the Save command on the Quick Access Toolbar.  

 

 
 

2. If you're saving the file for the first time, the Save As pane will appear in Backstage view.  

3. You'll then need to choose where to save the file and give it a file name. To save the workbook to 

your computer, select Computer, then click Browse. Alternatively, you can click OneDrive to save 

the file to your OneDrive. 

4. The Save As dialog box will appear. Select the location where you wish to save the workbook. 
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5. Enter a file name for the workbook, then click Save. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. The workbook will be saved. You can click the Save command again to save your changes as you 

modify the workbook. 

 

Using Save As to make a copy 

 

If you want to save a different version of a workbook while keeping the original, you can create a copy. 

For example, if you have a file named "Sales Data" you could save it as "Sales Data 2" so you'll be able to 

edit the new file and still refer back to the original version. 

To do this, you'll click the Save As command in Backstage view. Just like when saving a file for the first 

time, you'll need to choose where to save the file and give it a new file name. 

 

2.3.2. AutoRecover 

 

Excel automatically saves your workbooks to a temporary folder while you are working on them. If you 

forget to save your changes, or if Excel crashes, you can restore the file using AutoRecover. 

 

To use AutoRecover 

 

1. Open Excel 2013. If auto-saved versions of a file are found, the Document Recovery pane will 

appear.   

Choose a location, and 

then type the file name. 
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2. Click to open an available file. The workbook will be recovered. 

 

 

 

 

 TIP: By default, Excel autosaves every 10 minutes. If you are editing a workbook for less than 10 

minutes, Excel may not create an autosaved version. 

If you don't see the file you need, you can browse all autosaved files from Backstage view. Just select the 

File tab, click Manage Versions, and then choose Recover Unsaved Workbooks.  

 

2.3.3. Exporting workbooks 

 

By default, Excel workbooks are saved in the .xlsx file type. However, there may be times when you need 

to use another file type, such as a PDF or Excel 97-2003 workbook. It's easy to export your workbook from 

Excel in a variety of file types. 

To export a workbook as a PDF file 

Exporting your workbook as an Adobe Acrobat document, commonly known as a PDF file, can be especially 

useful if sharing a workbook with someone who does not have Excel. A PDF will make it possible for 

recipients to view, but not edit, the content of your workbook. 

1. Click the File tab to access Backstage view. 

2. Click Export, then select Create PDF/XPS. 
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3. The Save As dialog box will appear. Select the location where you wish to export the workbook, 

enter a file name, and then click Publish. 

 

 TIP: By default, Excel will only export the active worksheet. If you have multiple worksheets and 

want to save all of them in the same PDF file, click Options in the Save as dialog box. The Options 

dialog box will appear. Select Entire workbook, then click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To export a workbook in other file types 

 

You may also find it helpful to export your workbook in other file types, such as an Excel 97-2003 Workbook 

if you need to share with people using an older version of Excel, or a .CSV file if you need a plain-text 

version of your workbook. 
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1. Click the File tab to access Backstage view. 

2. Click Export, then select Change File Type. 

3. Select a common file type, then click Save As. 

4. The Save As dialog box will appear. Select the location where you wish to export the workbook, 

enter a file name, and then click Save. 

 

Challenge! 

5. Create a new blank workbook. 

6. Use the Save command to save the workbook to your desktop. 

7. Save the workbook to OneDrive and invite someone else to view it. 

8. Export the workbook as a PDF file. 

 

3. Cell Basics 

Whenever you work with Excel, you'll enter information, or content, into cells.  Cells are the basic building 

blocks of a worksheet. You'll need to learn the basics of cells and cell content to calculate, analyze, and 

organize data in Excel. 

 

3.1. Understanding Cells 

Every worksheet is made up of thousands of rectangles, which are called cells. A cell is the intersection of 

a row and a column. Columns are identified by letters (A, B, C), while rows are identified by numbers (1, 2, 

3). 

 

 

 

 

 

Colum

n 

Row Cell 
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Each cell has its own name, or cell address, based on its column and row. In this example, the selected cell 

intersects column C and row 5, so the cell address is C5. The cell address will also appear in the Name box. 

Note that a cell's column and row headings are highlighted when the cell is selected. 

 

 

 

 

 

You can also select multiple cells at the same time. A group of cells is known as a cell range. Rather than a 

single cell address, you will refer to a cell range using the cell addresses of the first and last cells in the cell 

range, separated by a colon. For example, a cell range that included cells A1, A2, A3, A4, and A5 would be 

written as A1:A5. 

In the images below, two different cell ranges are selected: 

 Cell range A1:A8 

 

 

 

 

 

 

 Cell range A1:B8  

Cell Address 
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To select a cell range 

Sometimes you may want to select a larger group of cells, or a cell range. 

1. Click, hold, and drag the mouse until all of the adjoining cells you wish to select are highlighted. 

2. Release the mouse to select the desired cell range. The cells will remain selected until you click 

another cell in the worksheet.  

3.2. Cell Content 

Any information you enter into a spreadsheet will be stored in a cell. Each cell can contain several different 

kinds of content, including text, formatting, formulas, and functions. 

 Text 

Cells can contain text, such as letters, numbers, and dates. 
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 Formatting Attributes 

Cells can contain formatting attributes that change the way letters, numbers, and dates are displayed. For 

example, percentages can appear as 0.15 or 15%. You can even change a cell's background color. 

 

 Formulas and Functions 

Cells can contain formulas and functions that calculate cell values. In our example, SUM(B4:B7) adds the 

value of each cell in cell range B4:B7 and displays the total in cell B8. 

 

 

 

 

 

 

 

 

 

 

 

To insert content 

1. Click a cell to select it. 

 

2. Type content into the selected cell, then press Enter on your keyboard. The content will appear 

in the cell and the formula bar. You can also input and edit cell content in the formula bar. 

 

 

 

 

 

 

 

 

Content appears in cell 

and formula bar 
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To delete cell content 

1. Select the cell with content you wish to delete. 

2. Press the Delete or Backspace key on your keyboard. The cell's contents will be deleted.  

To delete cells 

There is an important difference between deleting the content of a cell and deleting the cell itself. If you 

delete the entire cell, the cells below it will shift up and replace the deleted cells. 

1. Select the cell(s) you wish to delete. 

2. Select the Delete command from the Home tab on the Ribbon.  

3. The cells below will shift up. 

 

 

 

To copy and paste cell content 

Excel allows you to copy content that is already entered into your spreadsheet and paste that content to 

other cells, which can save you time and effort. 

1. Select the cell(s) you wish to copy. 

2. Click the Copy command on the Home tab, or press Ctrl+C on your keyboard. 
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3. Select the cell(s) where you wish to paste the content. The copied cells will now have a dashed 

box around them.  

4. Click the Paste command on the Home tab, or press Ctrl+V on your keyboard. 

5. The content will be pasted into the selected cells. 

 

To access more paste options 

You can also access additional paste options, which are especially convenient when working with cells that 

contain formulas or formatting. 

 To access more paste options, click the drop-down arrow on the Paste command. 
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 TIP: Rather than choosing commands from the Ribbon, you can access commands quickly by right-

clicking. Simply select the cell(s) you wish to format, then right-click the mouse. A drop-down menu 

will appear, where you'll find several commands that are also located on the Ribbon. 

 

 
 

To drag and drop cells 

Rather than cutting, copying, and pasting, you can drag and drop cells to move their contents. 

1. Select the cell(s) you wish to move. 

2. Hover the mouse over the border of the selected cell(s) until the cursor changes from a white 

cross to a black cross with four arrows.  

3. Click, hold, and drag the cells to the desired location. 

4. Release the mouse, and the cells will be dropped in the selected location. 

 

To use the fill handle 

There may be times when you need to copy the content of one cell to several other cells in your 

worksheet. You could copy and paste the content into each cell, but this method would be very time 

consuming. Instead, you can use the fill handle to quickly copy and paste content to adjacent cells in the 

same row or column. 

1. Select the cell(s) containing the content you wish to use. The fill handle will appear as a small 

square in the bottom-right corner of the selected cell(s).  
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2. Click, hold, and drag the fill handle until all of the cells you wish to fill are selected. 

 

 

 

 

 

 

 

 

 

 

 

3. Release the mouse to fill the selected cells. 

 

To continue a series with the fill handle 

The fill handle can also be used to continue a series. Whenever the content of a row or column follows a 

sequential order, like numbers (1, 2, 3) or days (Monday, Tuesday, Wednesday), the fill handle can guess 

what should come next in the series. In many cases, you may need to select multiple cells before using 

the fill handle to help Excel determine the series order. In our example below, the fill handle is used to 

extend a series of dates in a column. 

 

 

 

The fill handle 
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3.3. Find and Replace 

 

When working with a lot of data in Excel, it can be difficult and time consuming to locate specific 

information. You can easily search your workbook using the Find feature, which also allows you to modify 

content using the Replace feature. 

To find content 

1. From the Home tab, click the Find and Select command, then select Find... from the drop-down 

menu.  

 

 

 

 

 

 

2. The Find and Replace dialog box will appear. Enter the content you wish to find.  

3. Click Find Next. If the content is found, the cell containing that content will be selected. 
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4. Click Find Next to find further instances or Find All to see every instance of the search term. 

5. When you are finished, click Close to exit the Find and Replace dialog box. 

 

 TIP:  You can also access the Find command by pressing Ctrl+F on your keyboard. 

 TIP: Click Options to see advanced search criteria in the Find and Replace dialog box. 

 

 

 

 

 

 

 

 

 

 

To replace cell content 

At times, you may discover that you've repeatedly made a mistake throughout your workbook (such as 

misspelling someone's name), or that you need to exchange a particular word or phrase for another. You 

can use Excel's Find and Replace feature to make quick revisions.  
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1. From the Home tab, click the Find and Select command, then select Replace... from the drop-

down menu. 

2. The Find and Replace dialog box will appear. Type the text you wish to find in the Find what: field.  

3. Type the text you wish to replace it with in the Replace with: field, then click Find Next. 

4. If the content is found, the cell containing that content will be selected.  

5. Review the text to make sure you want to replace it.  

6. If you wish to replace it, select one of the replace options:  

 Replace will replace individual instances. 

 Replace All will replace every instance of the text throughout the workbook. In our example, we'll 

choose this option to save time. 

7. A dialog box will appear, confirming the number of replacements made. Click OK to continue. 

8. When you are finished, click Close to exit the Find and Replace dialog box. 

 

Challenge! 

1. Open an existing Excel 2013 workbook.  

2. Select cell D3. Notice how the cell address appears in the Name box and its content appears in 

both the cell and the Formula bar. 

3. Select a cell, and try inserting text and numbers. 

4. Delete a cell, and note how the cells below shift up to fill in its place. 

5. Cut cells and paste them into a different location.  

6. Try dragging and dropping some cells to other parts of the worksheet. 

7. Use the fill handle to fill in data to adjoining cells both vertically and horizontally. 

8. Use the Find feature to locate content in your workbook. 

 

4. Formatting Cells 

All cell content uses the same formatting by default, which can make it difficult to read a workbook with 

a lot of information. Basic formatting can customize the look and feel of your workbook, allowing you to 

draw attention to specific sections and making your content easier to view and understand. You can also 

apply number formatting to tell Excel exactly what type of data you’re using in the workbook, such as 

percentages (%), currency ($), and so on. 
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4.1. Font Formatting 
 

To change the font 

By default, the font of each new workbook is set to Calibri. However, Excel provides a variety of other 

fonts you can use to customize your cell text. In the example below, we'll format our title cell to help 

distinguish it from the rest of the worksheet. 

1. Select the cell(s) you wish to modify.  

2. Click the drop-down arrow next to the Font command on the Home tab. The Font drop-down 

menu will appear.  

3. Select the desired font. A live preview of the new font will appear as you hover the mouse over 

different options. 

 

 

 

 

 

4. The text will change to the selected font. 

 

 TIP: When creating a workbook in the workplace, you'll want to select a font that is easy to read. 

Along with Calibri, standard reading fonts include Cambria, Times New Roman, and Arial. 

To change the font size 

1. Select the cell(s) you wish to modify.  

2. Click the drop-down arrow next to the Font Size command on the Home tab. The Font Size drop-

down menu will appear. 

3. Select the desired font size. A live preview of the new font size will appear as you hover the 

mouse over different options.  

4. The text will change to the selected font size. 

 TIP: You can also use the Increase Font Size and Decrease Font Size commands or enter a custom 

font size using your keyboard. 
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To change the font color 

1. Select the cell(s) you wish to modify. 

2. Click the drop-down arrow next to the Font Color command on the Home tab. The Color menu 

will appear. 

3. Select the desired font color. A live preview of the new font color will appear as you hover the 

mouse over different options. 

 

 

 

 

 

 

 

 

 

4. The text will change to the selected font color.   

 

To use the Bold, Italic, and Underline commands 

1. Select the cell(s) you wish to modify.  

2. Click the Bold (B), Italic (I), or Underline (U) command on the Home tab. In our example, we'll 

make the selected cells bold.  

Entering a custom 

font size 
Increase and 

Decrease Font 

Size commands 
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3. The selected style will be applied to the text.  

 TIP: You can also press Ctrl+B on your keyboard to make selected text bold, Ctrl+I to apply italics, 

and Ctrl+U to apply an underline. 

 

4.2. Text Alignment 
 

By default, any text entered into your worksheet will be aligned to the bottom-left of a cell. Any numbers 

will be aligned to the bottom-right of a cell. Changing the alignment of your cell content allows you to 

choose how the content is displayed in any cell, which can make your cell content easier to read. 

To change horizontal text alignment 

1. Select the cell(s) you wish to modify.  

2. Select one of the three horizontal alignment commands on the Home tab. In our example, we'll 

choose Center Align. 

 

3. The text will realign.  

To change vertical text alignment 

1. Select the cell(s) you wish to modify.  

2. Select one of the three vertical alignment commands on the Home tab. In our example, we'll 

choose Middle Align.  
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3. The text will realign.  

 

4.3. Cell borders and fill colors 
 

Cell borders and fill colors allow you to create clear and defined boundaries for different sections of your 

worksheet.  

To add a border 

1. Select the cell(s) you wish to modify.  

2. Click the drop-down arrow next to the Borders command on the Home tab. The Borders drop-

down menu will appear. 

 

 

 

 

 

 

 

 

 

3. Select the border style you want to use.  

4. The selected border style will appear.  

 TIP: You can draw borders and change the line style and color of borders with the Draw Borders 

tools at the bottom of the Borders drop-down menu. 
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To add a fill color 

1. Select the cell(s) you wish to modify.  

2. Click the drop-down arrow next to the Fill Color command on the Home tab. The Fill Color menu 

will appear. 

3. Select the fill color you want to use. A live preview of the new fill color will appear as you hover 

the mouse over different options. In our example, we'll choose Light Green.  

 

 

 

 

 

 

 

 

 

 

4. The selected fill color will appear in the selected cells.  
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4.4. Cell styles 
 

Rather than formatting cells manually, you can use Excel's predesigned cell styles. Cell styles are a quick 

way to include professional formatting for different parts of your workbook, such as titles and headers. 

To apply a cell style 

1. Select the cell(s) you wish to modify. 

2. Click the Cell Styles command on the Home tab, then choose the desired style from the drop-down 

menu.  

 

 

 

 

 

 

3. The selected cell style will appear.  

 TIP: Applying a cell style will replace any existing cell formatting except for text alignment. You may 

not want to use cell styles if you've already added a lot of formatting to your workbook. 

 

4.5. Formatting text and numbers 
 

One of the most powerful tools in Excel is the ability to apply specific formatting for text and numbers. 

Instead of displaying all cell content in exactly the same way, you can use formatting to change the 

appearance of dates, times, decimals, percentages (%), currency ($), and much more. 

To apply number formatting 

1. Select the cells(s) you wish to modify.  

2. Click the drop-down arrow next to the Number Format command on the Home tab. The Number 

Formatting drop-down menu will appear. 

3. Select the desired formatting option.  

4. The selected cells will change to the new formatting style.  
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Challenge! 

1. Open an existing Excel 2013 workbook.  

2. Select a cell and change the font style, size, and color of the text.  

3. Apply bold, italics, or underline to a cell.  

4. Try changing the vertical and horizontal text alignment for some cells. 

5. Add a border to a cell range. 

6. Change the fill color of a cell range.  

7. Try changing the formatting of a number.  

General is the default format for any cell. 

When you enter a number into the cell, 

Excel will guess the number format that is 

most appropriate. 
Number formats numbers 

with decimal places. 

Currency formats numbers as currency 

with a currency symbol. 

Accounting formats numbers as monetary 

values like the Currency format, but it also 

aligns currency symbols and decimal 

places within columns.  

 

Short Date formats numbers 

as M/D/YYYY. 

Long Date formats numbers as 

Weekday, Month DD, YYYY. 

Time formats numbers as HH/MM/SS 

and notes AM or PM. 

Percentage formats numbers with 

decimal places and the percent sign. 

Fraction formats numbers as fractions 

separated by the forward slash. 

Scientific formats numbers 

in scientific notation. 

Text formats numbers as text, meaning 

that what you enter into the cell will 

appear exactly as it was entered. 

You can easily customize any format in 

More Number Formats. 
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5. Modifying Columns, Rows and Cells 

By default, every row and column of a new workbook is always set to the same height and width. Excel 

allows you to modify column width and row height in different ways, including wrapping text and merging 

cells. 

 

To modify column width 

1. Position the mouse over the column line in the column heading so the white cross becomes a 

double arrow  . 

 

2. Click, hold, and drag the mouse to increase or decrease the column width. 

3. Release the mouse. The column width will be changed. 

 TIP: If you see pound signs (#######) in a cell, it means that the column is not wide enough to 

display the cell content. Simply increase the column width to show the cell content. 

 

To AutoFit column width 

The AutoFit feature will allow you to set a column's width to fit its content automatically. 

1. Position the mouse over the column line in the column heading so the white cross becomes a 

double arrow .  

2. Double-click the mouse. The column width will be changed automatically to fit the content. 

 TIP: You can also AutoFit the width for several columns at the same time. Simply select the columns 

you would like to AutoFit, then select the AutoFit Column Width command from the Format drop-

down menu on the Home tab. This method can also be used for Row height. 
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To modify row height 

1. Position the cursor over the row line so the white cross becomes a double arrow . 

2. Click, hold, and drag the mouse to increase or decrease the row height. 

3. Release the mouse. The height of the selected row will be changed. 

 

To modify all rows or columns 

Rather than resizing rows and columns individually, you can modify the height and width of every row and 

column at the same time. This method allows you to set a uniform size for every row and column in your 

worksheet. 

1. Locate and click the Select All button just below the formula bar to select every cell in the 

worksheet. 

 

 

 

 

 

 

2. Position the mouse over a row line so the white cross becomes a double arrow . 

3. Click, hold, and drag the mouse to increase or decrease the row height. 

4. Release the mouse when you are satisfied with the new row height for the worksheet. 
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5.1. Inserting, deleting, moving, and hiding rows and columns 

 

After you've been working with a workbook for a while, you may find that you want to insert new columns 

or rows, delete certain rows or columns, move them to a different location in the worksheet, or even hide 

them. 

To insert rows 

1. Select the row heading below where you want the new row to appear.  

2. Click the Insert command on the Home tab. 

 

3. The new row will appear above the selected row. 

 

 TIP: When inserting new rows, columns, or cells, you will see the Insert Options button next to 

the inserted cells. This button allows you to choose how Excel formats these cells. By default, Excel 

formats inserted rows with the same formatting as the cells in the row above. To access more 

options, hover your mouse over the Insert Options button, then click the drop-down arrow. 
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To insert columns 

1. Select the column heading to the right of where you want the new column to appear. 

2. Click the Insert command on the Home tab. 

 

3. The new column will appear to the left of the selected column. 

 

 TIP: When inserting rows and columns, make sure you select the entire row or column by clicking 

the heading. If you select only a cell in the row or column, the Insert command will only insert a 

new cell.  

 

To delete rows 

It's easy to delete any row that you no longer need in your workbook. 

1. Select the row(s) you want to delete.  

2. Click the Delete command on the Home tab.  
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3. The selected row(s) will be deleted, and the rows below will shift up. 

To delete columns 

1. Select the columns(s) you want to delete.  

2. Click the Delete command on the Home tab. 

 

 

 

 

3. The selected columns(s) will be deleted, and the columns to the right will shift left.  

 TIP: It's important to understand the difference between deleting a row or column and simply 

clearing its contents. If you want to remove the content of a row or column without causing others 

to shift, right-click a heading, then select Clear Contents from the drop-down menu. 
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To move a row or column 

Sometimes you may want to move a column or row to rearrange the content of your worksheet.  

1. Select the desired column heading for the column you wish to move, then click the Cut command 

on the Home tab or press Ctrl+X on your keyboard.  

2. Select the column heading to the right of where you want to move the column. For example, if you 

want to move a column between columns B and C, select column C. 

3. Click the Insert command on the Home tab, then select Insert Cut Cells from the drop-down menu. 

 

4. The column will be moved to the selected location, and the columns to the right will shift right. 

 

 TIP: You can also access the Cut and Insert commands by right-clicking the mouse and then 

selecting the desired commands from the drop-down menu. 

 

To hide and unhide a row or column 

At times, you may want to compare certain rows or columns without changing the organization of your 

worksheet. Excel allows you to hide rows and columns as needed.  

1. Select the column(s) you wish to hide, right-click the mouse, then select Hide from the formatting 

menu. 

 

 

 

 

 

 

 



  Excel Training - Level 1 

Page | 55  

2. The columns will be hidden. The green column line indicates the location of the hidden columns. 

 

 

 

 

 

 

 

3. To unhide the columns, select the columns to the left and right of the hidden columns (in other 

words, the columns on both sides of the hidden columns).  

4. Right-click the mouse, then select Unhide from the formatting menu. The hidden columns will 

reappear. 

 

5.2. Wrapping text and merging cells 
 

Whenever you have too much cell content to be displayed in a single cell, you may decide to wrap the text 

or merge the cell rather than resizing a column. Wrapping the text will automatically modify a cell's row 

height, allowing cell contents to be displayed on multiple lines. Merging allows you to combine a cell with 

adjacent, empty cells to create one large cell. 

1. Select the cells you wish to wrap. 

2. Select the Wrap Text command on the Home tab. 

 

 

 

 

 

 

 

 

Green 

column line 
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3. The text in the selected cells will be wrapped. 

 TIP: Click the Wrap Text command again to unwrap the text. 

 

To merge cells using the Merge & Center command 

1. Select the cell range you want to merge together. 

2. Select the Merge & Center command on the Home tab. 

 

 

 

 

 

 

 

 

 

3. The selected cells will be merged, and the text will be centered. 

To access more merge options 

Click the drop-down arrow next to the Merge & Center command on the Home tab. The Merge drop-down 

menu will appear. From here, you can choose to: 

 Merge & Center: Merges the selected cells into one cell and centers the text 

 Merge Across: Merges the selected cells into larger cells while keeping each row separate 

 Merge Cells: Merges the selected cells into one cell, but does not center the text 

 Unmerge Cells: Unmerges selected cells 
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Challenge! 

1. Open an existing Excel 2013 workbook. 

2. Modify the width of a column.  

3. Insert a column between column A and column B, then insert a row between row 3 and row 4. 

4. Delete a column or a row. 

5. Move a column or row. 

6. Try using the Text Wrap command on a cell range.  

7. Try merging some cells together.  

 

6. Formulas and Functions 

One of the most powerful features in Excel is the ability to calculate numerical information using formulas. 

 

6.1. Simple Formulas 

 

Just like a calculator, Excel can add, subtract, multiply, and divide. In this lesson, we'll show you how to 

use cell references to create simple formulas. 

Mathematical operators 

Excel uses standard operators for formulas, such as a plus sign for addition (+), a minus sign for subtraction 

(-), an asterisk for multiplication (*), a forward slash for division (/), and a caret (^) for exponents.  

 

 

All formulas in Excel must begin with an equals sign (=). This is because the cell contains, or is equal to, 

the formula and the value it calculates. 
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Understanding cell references 

While you can create simple formulas in Excel manually (for example, =2+2 or =5*5), most of the time you 

will use cell addresses to create a formula. This is known as making a cell reference. Using cell references 

will ensure that your formulas are always accurate because you can change the value of referenced cells 

without having to rewrite the formula. 

 

 

 

 

 

 

 

 

 

 

 

 

By combining a mathematical operator with cell references, you can create a variety of simple formulas 

in Excel. Formulas can also include a combination of cell references and numbers, as in the examples 

below: 

 

 

The formula in cell A3 

refers to the value in cell A1 

plus the value in cell A2 

The formula calculates 

and displays the answer 

to the equation A1 plus A2 
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To create a formula 

1. Select the cell that will contain the formula.  

2. Type the equals sign (=). Notice how it appears in both the cell and the formula bar. 

 

 

 

 

 

 

 

 

1. Type the cell address of the cell you wish to reference first in the formula: cell D1 in our example. 

A blue border will appear around the referenced cell.  

2. Type the mathematical operator you wish to use. In our example, we'll type the addition sign (+). 

3. Type the cell address of the cell you wish to reference second in the formula: cell D2 in our 

example. A red border will appear around the referenced cell.  

 

4. Press Enter on your keyboard. The formula will be calculated, and the value will be displayed in the 

cell.  

 TIP: If the result of a formula is too large to be displayed in a cell, it may appear as pound 

signs (#######) instead of a value. This means that the column is not wide enough to display the 

cell content. Simply increase the column width to show the cell content. 

 

Modifying values with cell references 

The true advantage of cell references is that they allow you to update data in your worksheet without 

having to rewrite formulas.  

 TIP: Excel will not always tell you if your formula contains an error, so it's up to you to check all of 

your formulas.  

 

Formula will appear in 

both the cell and the 

formula bar. 
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To create a formula using the point-and-click method 

Rather than typing cell addresses manually, you can point and click on the cells you wish to include in your 

formula. This method can save a lot of time and effort when creating formulas. In our example below, 

we'll create a formula to calculate the cost of ordering several boxes of plastic silverware. 

1. Select the cell that will contain the formula. In our example, we'll select cell D3.  

 

 

2. Type the equals sign (=). 

3. Select the cell you wish to reference first in the formula: cell B3 in our example. The cell address 

will appear in the formula, and a dashed blue line will appear around the referenced cell.  

 

 

4. Type the mathematical operator you wish to use. In our example, we'll type the multiplication sign 

(*). 

5. Select the cell you wish to reference second in the formula: cell C3 in our example. The cell address 

will appear in the formula, and a dashed red line will appear around the referenced cell.  
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6. Press Enter on your keyboard. The formula will be calculated, and the value will be displayed in the 

cell.  

 

 

Formulas can also be copied to adjacent cells with the fill handle, which can save a lot of time and effort 

if you need to perform the same calculation multiple times in a worksheet.  

To edit a formula 

Sometimes you may want to modify an existing formula. In the example below, we've entered an incorrect 

cell address in our formula, so we'll need to correct it. 

1. Select the cell containing the formula you wish to edit. 

2. Click the formula bar to edit the formula. You can also double-click the cell to view and edit the 

formula directly within the cell.  

3. A border will appear around any referenced cells. 

4. When finished, press Enter on your keyboard or select the Enter command in the formula bar.  

5. The formula will be updated, and the new value will be displayed in the cell.  

 TIP: If you change your mind, you can press the Esc key on your keyboard or click the Cancel 

command in the formula bar to avoid accidentally making changes to your formula. 
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 TIP: To show all of the formulas in a spreadsheet, you can hold the Ctrl key and press ` (grave 

accent). The grave accent key is usually located in the upper-left corner of the keyboard. You can 

press Ctrl+` again to switch back to the normal view. 

 

Challenge! 

1. Open an existing Excel workbook.  

2. Create a simple addition formula using cell references.  

3. Try modifying the value of a cell referenced in a formula.  

4. Try using the point-and-click method to create a formula.  

5. Edit a formula using the formula bar.  

 

6.2. Complex Formulas 

 

A simple formula is a mathematical expression with one operator, such as 7+9. A complex formula has 

more than one mathematical operator, such as 5+2*8. When there is more than one operation in a 

formula, the order of operations tells Excel which operation to calculate first. In order to use Excel to 

calculate complex formulas, you will need to understand the order of operations. 

Order of operations 

Excel calculates formulas based on the following order of operations: 

1. Operations enclosed in parentheses 

2. Exponential calculations (3^2, for example) 

3. Multiplication and division, whichever comes first 

4. Addition and subtraction, whichever comes first 

 

Creating complex formulas 

In the example below, we will demonstrate how Excel solves a complex formula using the order of 

operations. Here, we want to calculate the cost of sales tax for an invoice. To do this, we'll write our 

formula as =(D2+D3)*0.075 in cell D4. This formula will add the prices of our items together and then 

multiply that value by the 7.5% tax rate (which is written as 0.075) to calculate the cost of sales tax. 
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 TIP: It is especially important to enter complex formulas with the correct order of operations. 

Otherwise, Excel will not calculate the results accurately. In our example, if the parentheses are 

not included, the multiplication is calculated first and the result is incorrect. Parentheses are the 

best way to define which calculations will be performed first in Excel. 

 

Challenge! 

1. Open an existing Excel workbook.  

2. Create a complex formula that will perform addition before multiplication. 

 

6.2.1. Relative and Absolute Cell References 

 

There are two types of cell references: relative and absolute. Relative and absolute references behave 

differently when copied and filled to other cells. Relative references change when a formula is copied to 

another cell. Absolute references, on the other hand, remain constant, no matter where they are copied. 

 

6.2.2. Relative cell references 

 

By default, all cell references are relative references. When copied across multiple cells, they change based 

on the relative position of rows and columns. For example, if you copy the formula =A1+B1 from row 1 to 

row 2, the formula will become =A2+B2. Relative references are especially convenient whenever you need 

to repeat the same calculation across multiple rows or columns. 

 

To create and copy a formula using relative references 

In the following example, we want to create a formula that will multiply each item's price by the quantity. 

Rather than creating a new formula for each row, we can create a single formula in cell D2 and then copy 
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it to the other rows. We'll use relative references so the formula correctly calculates the total for each 

item. 

1. Select the cell that will contain the formula. In our example, we'll select cell D2. 

2. Enter the formula to calculate the desired value. In our example, we'll type =B2*C2. 

 

 

 

 

 

 

 

 

 

 

3. Press Enter on your keyboard. The formula will be calculated, and the result will be displayed in 

the cell. 

4. Locate the fill handle in the lower-right corner of the desired cell. In our example, we'll locate the 

fill handle for cell D2. 

 

 

 

 

 

 

 

 

 

 

The fill handle 
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5. Click, hold, and drag the fill handle over the cells you wish to fill. 

 

 

 

 

 

 

 

 

 

 

 

6. Release the mouse. The formula will be copied to the selected cells with relative references, and 

the values will be calculated in each cell. 

 

 TIP: You can double-click the filled cells to check their formulas for accuracy. The relative cell 

references should be different for each cell, depending on their rows. 

 

 

 

 

 

 

 

 

 

 

Click, hold and drag the fill handle to 

copy the formula to adjacent cells 
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6.2.3. Absolute cell references 

 

There may be times when you do not want a cell reference to change when filling cells. Unlike relative 

references, absolute references do not change when copied or filled. You can use an absolute reference to 

keep a row and/or column constant. 

An absolute reference is designated in a formula by the addition of a dollar sign ($). It can precede the 

column reference, the row reference, or both. 

 

You will generally use the $A$2 format when creating formulas that contain absolute references. The 

other two formats are used much less frequently. 

 TIP: When writing a formula, you can press the F4 key on your keyboard to switch between relative 

and absolute cell references. This is an easy way to quickly insert an absolute reference. 

 

To create and copy a formula using absolute references 

In our example, we'll use the 7.5% sales tax rate in cell E1 to calculate the sales tax for all items in column 

D. We'll need to use the absolute cell reference $E$1 in our formula. Since each formula is using the same 

tax rate, we want that reference to remain constant when the formula is copied and filled to other cells 

in column D. 

1. Select the cell that will contain the formula. In our example, we'll select cell D3.  

2. Enter the formula to calculate the desired value. In our example, we'll type =(B3*C3)*$E$1. 

3. Press Enter on your keyboard. The formula will calculate, and the result will display in the cell. 
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4. Locate the fill handle in the lower-right corner of the desired cell.  

5. Release the mouse. The formula will be copied to the selected cells with an absolute reference, 

and the values will be calculated in each cell. 

Challenge! 

1. Open an existing Excel workbook.  

2. Create a formula that uses a relative reference. Double-click a cell to see the copied formula and 

the relative cell references. 

3. Create a formula that uses an absolute reference.  

 

6.3. Functions 

 

A function is a predefined formula that performs calculations using specific values in a particular order. 

Excel includes many common functions that can be useful for quickly finding the sum, average, count, 

maximum value, and minimum value for a range of cells. In order to use functions correctly, you'll need to 

understand the different parts of a function and how to create arguments to calculate values and cell 

references. 

Formula =A1+A2+A3+A4+A5+A6+A7+A8 

Function =SUM(A1:A8) 

The parts of a function 

In order to work correctly, a function must be written a specific way, which is called the syntax. The basic 

syntax for a function is an equals sign (=), the function name (SUM, for example), and one or more 

arguments. Arguments contain the information you want to calculate.  
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Working with arguments 

Arguments can refer to both individual cells and cell ranges and must be enclosed within parentheses. You 

can include one argument or multiple arguments, depending on the syntax required for the function. 

 

For example, the function =AVERAGE(B1:B9) would calculate the average of the values in the cell range 

B1:B9. This function contains only one argument. 

 

 

Multiple arguments must be separated by a comma. For example, the function =SUM(A1:A3, C1:C2, E2) 

will add the values of all the cells in the three arguments. 

Equal sign 

Function name 

Argument 

=SUM(A1:A20) 
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6.3.1. Creating a function 
 

Excel has a variety of functions available. Here are some of the most common functions you'll use: 

 SUM: This function adds all of the values of the cells in the argument. 

 AVERAGE: This function determines the average of the values included in the argument. It 

calculates the sum of the cells and then divides that value by the number of cells in the argument. 

 COUNT: This function counts the number of cells with numerical data in the argument. This 

function is useful for quickly counting items in a cell range. 

 MAX: This function determines the highest cell value included in the argument. 

 MIN: This function determines the lowest cell value included in the argument. 

 

To create a basic function 

In our example below, we'll create a basic function to calculate the average price per unit for a list of 

recently ordered items using the AVERAGE function. 

1. Select the cell that will contain the function. 

2. Type the equals sign (=) and enter the desired function name. You can also select the desired 

function from the list of suggested functions that will appear below the cell as you type. In our 

example, we'll type =AVERAGE. 
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3. Enter the cell range for the argument inside parentheses. In our example, we'll type (D3:D12). 

4. Press Enter on your keyboard. The function will be calculated, and the result will appear in the cell. 

 

To create a function using the AutoSum command 

The AutoSum command allows you to automatically insert the most common functions into your formula, 

including SUM, AVERAGE, COUNT, MIN, and MAX. In our example below, we'll create a function to 

calculate the total cost for a list of recently ordered items using the SUM function. 

1. Select the cell that will contain the function.  

2. In the Editing group on the Home tab, locate and select the arrow next to the AutoSum command 

and then choose the desired function from the drop-down menu. In our example, we'll select Sum. 
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3. The selected function will appear in the cell. If logically placed, the AutoSum command will 

automatically select a cell range for the argument. You can also manually enter the desired cell 

range into the argument. 

 

 

 

 

 

 

 

 

 

4. Press Enter on your keyboard.  

 

6.3.2. The Function Library 

 

While there are hundreds of functions in Excel, the ones you use most frequently will depend on the type 

of data your workbooks contains. There is no need to learn every single function, but exploring some of 

the different types of functions will be helpful as you create new projects. You can search for functions by 

category, such as Financial, Logical, Text, Date & Time, and more from the Function Library on the Formulas 

tab. 

 To access the Function Library, select the Formulas tab on the Ribbon. The Function Library will 

appear.  
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 If you're having trouble finding the right function, the Insert Function command allows you to 

search for functions using keywords. 

 The AutoSum command allows you to automatically return results for common functions, like 

SUM, AVERAGE, and COUNT. 

 The Recently Used command gives you access to functions that you have recently worked with. 

 The Financial category contains functions for financial calculations like determining a payment (PMT) or 

interest rate for a loan (RATE). 

 Functions in the Logical category check arguments for a value or condition. For example, if an order is over 

$50 add $4.99 for shipping, but if it is over $100, do not charge for shipping (IF). 

 The Text category contains functions that work with the text in arguments to perform tasks, such as 

converting text to lowercase (LOWER) or replacing text (REPLACE). 

 The Date & Time category contains functions for working with dates and time and will return results like 

the current date and time (NOW) or the seconds (SECOND). 

 The Lookup & Reference category contains functions that will return results for finding and referencing 

information. For example, you can add a hyperlink (HYPERLINK) to a cell or return the value of a particular 

row and column intersection (INDEX). 

 The Math & Trig category includes functions for numerical arguments. For example, you can round values 

(ROUND), find the value of Pi (PI) multiply (PRODUCT), subtotal (SUBTOTAL), and much more. 

 More Functions contains additional functions under categories for Statistical, Engineering, Cube, 

Information, and Compatibility. 

To insert a function from the Function Library 

1. Select the cell that will contain the function. 

2. Click the Formulas tab on the Ribbon to access the Function Library.  

3. From the Function Library group, select the desired function category. 

4. Select the desired function from the drop-down menu. 
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5. The Function Arguments dialog box will appear. From here, you'll be able to enter or select the 

cells that will make up the arguments in the function. 

 

 

 

 

 

 

 

6. When you're satisfied with the arguments, click OK. 

7. The function will be calculated, and the result will appear in the cell. 
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Like formulas, functions can be copied to adjacent cells. Hover the mouse over the cell that contains the 
function, then click, hold, and drag the fill handle over the cells you wish to fill. The function will be copied, 
and values for those cells will be calculated relative to their rows or columns. 

 

 

 

 

 

 

 

 

 

 

6.3.3. The Insert Function command 

 

If you're having trouble finding the right function, the Insert Function command allows you to search for 

functions using keywords. While it can be extremely useful, this command is sometimes a little difficult to 

use. If you don't have much experience with functions, you may have more success browsing the Function 

Library instead. For more advanced users, however, the Insert Function command can be a powerful way 

to find a function quickly. 

 

To use the Insert Function command 

1. Select the cell that will contain the function. 

2. Click the Formulas tab on the Ribbon, then select the Insert Function command. 

3. The Insert Function dialog box will appear. 

4. Type a few keywords describing the calculation you want the function to perform, then click Go. 

5. Review the results to find the desired function, then click OK. 
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6. The Function Arguments dialog box will appear. 

7. When you're satisfied, click OK. 

8. The function will be calculated, and the result will appear in the cell. 

 

Challenge! 

1. Open an existing Excel workbook.  

2. Create a function that contains one argument. If you're using the example, use the SUM function 

in cell B16 to calculate the total quantity of items ordered. 

3. Use the AutoSum command to insert a function.  

4. Explore the Function Library, and try using the Insert Function command to search for different 

types of functions. 
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Excel Formulas You Should Definitely Know 

1. SUM 

Formula: =SUM(5, 5) or =SUM(A1, B1) or =SUM(A1:B5) 

The SUM formula does exactly what you would expect. It allows you to add 2 or more numbers together. 

You can use cell references as well in this formula. 

 

2. COUNT 

Formula: =COUNT(A1:A10) 

The count formula counts the number of cells in a range that have numbers in them. 

 

It only counts the cells where there are numbers. 

 

3. COUNTA 

Formula: =COUNTA(A1:A10) 

Counts the number of non-empty cells in a range. It will count cells that have numbers and/or any other 

characters in them. 

The COUNTA Formula works with all data types. 
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It counts the number of non-empty cells no matter the data type. 

4. LEN 

Formula: =LEN(A1) 

The LEN formula counts the number of characters in a cell. This includes spaces! 

 

Notice the difference in the formula results: 10 characters without spaces in between the words, 12 with 

spaces between the words. 

5. VLOOKUP 

Formula: =VLOOKUP(lookup_value, table_array, col_index_num, range_lookup) 

Basically, VLOOKUP lets you search for specific information in your spreadsheet. For example, if you have 

a list of products with prices, you could search for the price of a specific item. 

We’re going to use VLOOKUP to find the price of the Photo frame. You can probably already see that the 

price is $9.99, but that’s because this is a simple example. Once you learn how to use VLOOKUP, you’ll be 

able to use it with larger, more complex spreadsheets, and that’s when it will become truly useful. 
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As with any formula, you’ll start with an equal sign (=). Then, type the formula name. 

=VLOOKUP(“Photo frame” 

The second argument is the cell range that contains the data. In this example, our data is in A2:B16. As 

with any function, you’ll need to use a comma to separate each argument: 

=VLOOKUP(“Photo frame”, A2:B16 

Note: It’s important to know that VLOOKUP will always search the first column in this range. In this 

example, it will search column A for “Photo frame”. In some cases, you may need to move the columns 

around so that the first column contains the correct data. 

The third argument is the column index number. It’s simpler than it sounds: The first column in the range 

is 1, the second column is 2, etc. In this case, we are trying to find the price of the item, and the prices are 

contained in the second column. That means our third argument will be 2: 

=VLOOKUP(“Photo frame”, A2:B16, 2 

The fourth argument tells VLOOKUP whether to look for approximate matches, and it can be either TRUE 

or FALSE. If it is TRUE, it will look for approximate matches. Generally, this is only useful if the first column 

has numerical values that have been sorted. Since we’re only looking for exact matches, the fourth 

argument should be FALSE. This is our last argument, so go ahead and close the parentheses: 

=VLOOKUP(“Photo frame”, A2:B16, 2, FALSE) 

And that’s it! When you press enter, it should give you the answer, which is 9.99. 
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6. IF Statements 

Formula: =IF(logical_statement, return this if logical statement is true, return this if logical statement is 

false). 

Example 

Let’s say a salesperson has a quota to meet. You used VLOOKUP to put the revenue next to the name. Now you can 

use an IF statement that says: “IF the salesperson met their quota, say “Met quota”, if not say “Did not meet quota” 

=IF(C3>D3, “Met Quota”, “Did Not Meet Quota”) 

This IF statement will tell us if the first salesperson met their quota or not. We would then copy and paste 

this formula along all the entries in the list. It would change for each sales person. 
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7. Working with Data 

Whenever you're working with a lot of data, it can be difficult to compare information in your workbook. 

7.1 Freezing Panes and View Options 
 

Excel includes several tools that make it easier to view content from different parts of your workbook at 

the same time, such as the ability to freeze panes and split your worksheet. 

To freeze rows 

You may want to see certain rows or columns all the time in your worksheet, especially header cells. By 

freezing rows or columns in place, you'll be able to scroll through your content while continuing to view 

the frozen cells. 

1. Select the row below the row(s) you wish to freeze. 

2. Click the View tab on the Ribbon.  

3. Select the Freeze Panes command, then choose Freeze Panes from the drop-down menu. 

 

 

 

 

 

 

 

 

 

 

 

The rows will be frozen in place, as indicated by the gray line. You can scroll down the worksheet while 

continuing to view the frozen rows at the top. 

To freeze columns 

1. Select the column to the right of the column(s) you wish to freeze. 
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2. Click the View tab on the Ribbon. 

3. Select the Freeze Panes command, then choose Freeze Panes from the drop-down menu. 

4. The column will be frozen in place, as indicated by the gray line. You can scroll across the 

worksheet while continuing to view the frozen column on the left. 

To unfreeze rows or columns, click the Freeze Panes command, then select Unfreeze Panes from the 

drop-down menu. 

 

To split a worksheet 

Sometimes you may want to compare different sections of the same workbook without creating a new 

window. The Split command allows you to divide the worksheet into multiple panes that scroll 

separately. 

1. Select the cell where you wish to split the worksheet. 

2. Click the View tab on the Ribbon, then select the Split command.  

 

3. The workbook will be split into different panes. You can scroll through each pane separately 

using the scroll bars, allowing you to compare different sections of the workbook. 

To remove the split, click the Split command again. 

 

Challenge! 

1. Open an existing Excel workbook.  

2. Try freezing a row or column in place.  

3. Use the Split command to split your worksheet into multiple panes. 

 

7.2 Sorting Data 
 

As you add more content to a worksheet, organizing that information becomes especially important. You 

can quickly reorganize a worksheet by sorting your data. For example, you could organize a list of contact 

information by last name. Content can be sorted alphabetically, numerically, and in many other ways. 
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When sorting data, it's important to first decide if you would like the sort to apply to the entire worksheet 

or just a cell range.  

 Sort sheet organizes all of the data in your worksheet by one column.  

 Sort range sorts the data in a range of cells, which can be helpful when working with a sheet that 

contains several tables. Sorting a range will not affect other content on the worksheet. 

 

To sort a sheet 

In our example, we'll sort a T-shirt order form alphabetically by Last Name (column C). 

1. Select a cell in the column you wish to sort by. In our example, we'll select cell C2.  

 

 

2. Select the Data tab on the Ribbon, then click the Ascending command  to Sort A to Z, or the 

Descending command  to Sort Z to A. In our example, we'll click the Ascending command.  

 

 

3. The worksheet will be sorted by the selected column. In our example, the worksheet is now sorted 

by last name. 
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7.3 Filtering Data 

 

If your worksheet contains a lot of content, it can be difficult to find information quickly. Filters can be 

used to narrow down the data in your worksheet, allowing you to view only the information you need. 

To filter data 

1. In order for filtering to work correctly, your worksheet should include a header row, which is used 

to identify the name of each column. 

2. Select the Data tab, then click the Filter command.  

 

 

 

 

 

 

 

 

 

 

3. A drop-down arrow will appear in the header cell for each column.  

4. Click the drop-down arrow for the column you wish to filter. 
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5. The Filter menu will appear.  

6. Uncheck the box next to Select All to quickly deselect all data. 

7. Check the boxes next to the data you wish to filter, then click OK. 

To remove all filters from your worksheet, click the Filter command on the Data tab. 

 

8. Working with Charts 

Creating a chart in Microsoft Office Excel is quick and easy. Excel provides a variety of chart types that you 

can choose from when you create a chart. Excel offers Pie, Line, Bar, and Column charts to name but a 

few. Showing data in a chart can make it clearer, more interesting and easier to read. Charts can also help 

you evaluate your data and make comparisons between different values. 

 

8.1. Understanding charts 
 

Excel has several different types of charts, allowing you to choose the one that best fits your data. In order 

to use charts effectively, you'll need to understand how different charts are used. 

Types of Charts: 

 Column charts use vertical bars to represent data. They can work with many different types of 

data, but they're most frequently used for comparing information. 

 Line charts are ideal for showing trends. The data points are connected with lines, making it easy 

to see whether values are increasing or decreasing over time. 

 Pie charts make it easy to compare proportions. Each value is shown as a slice of the pie, so it's 

easy to see which values make up the percentage of a whole. 

 Bar charts work just like Column charts, but they use horizontal bars instead of vertical bars. 

 Area charts are similar to line charts, except that the areas under the lines are filled in. 

 Surface charts allow you to display data across a 3D landscape. They work best with large data sets, 

allowing you to see a variety of information at the same time. 

 

To insert a chart 

 

1. Select the cells you want to chart, including the column titles and row labels. These cells will be 

the source data for the chart.  
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2. From the Insert tab, click the desired Chart command.  

3. Choose the desired chart type from the drop-down menu. 

 

 

 

 

 

 

 

 

 

4. The selected chart will be inserted in the worksheet. 

 TIP:  If you're not sure which type of chart to use, the Recommended Charts command will 

suggest several different charts based on the source data.  

 

 
 

8.2. Chart layout and style 
 

After inserting a chart, there are several things you may want to change about the way your data is 

displayed. It's easy to edit a chart's layout and style from the Design tab. 

 Excel allows you to add chart elements—such as chart titles, legends, and data labels—to make 

your chart easier to read. To add a chart element, click the Add Chart Element command on the 

Design tab, then choose the desired element from the drop-down menu.  
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 To edit a chart element, like a chart title, simply double-click the placeholder and begin typing.  

 

 

 

 

 

 

 

 

 

 

 If you don't want to add chart elements individually, you can use one of Excel's predefined layouts. 

Simply click the Quick Layout command, then choose the desired layout from the drop-down 

menu. 

 Excel also includes several different chart styles, which allow you to quickly modify the look and 

feel of your chart. To change the chart style, select the desired style from the Chart styles group. 
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 TIP: You can also use the chart formatting shortcut buttons to quickly add chart elements, change 

the chart style, and filter the chart data. 

 

 

 

 

 

 

 

 

 

 

 

 

8.3. Other chart options 
 

There are lots of other ways to customize and organize your charts. For example, Excel allows you to 

rearrange a chart's data, change the chart type, and even move the chart to a different location in the 

workbook. 

To switch row and column data 

Sometimes you may want to change the way charts group your data. For example, in the chart below, the 

Book Sales data are grouped by year, with columns for each genre. However, we could switch the rows 

and columns so the chart will group the data by genre, with columns for each year. In both cases, the chart 

contains the same data—it's just organized differently. 

1. Select the chart you wish to modify. 



  Excel Training - Level 1 

Page | 88  

2. From the Design tab, select the Switch Row/Column command.  

 

3. The rows and columns will be switched.  

 

To change the chart type 

If you find that your data isn't well suited to a certain chart, it's easy to switch to a new chart type. In our 

example, we'll change our chart from a Column chart to a Line chart. 

1. From the Design tab, click the Change Chart Type command.  

 

2. The Change Chart Type dialog box will appear.  

3. The selected chart type will appear.  

 

To move a chart 

Whenever you insert a new chart, it will appear as an object on the same worksheet that contains its 

source data. Alternatively, you can move the chart to a new worksheet to help keep your data organized. 

1. Select the chart you wish to move. 

2. Click the Design tab, then select the Move Chart command.  
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3. The Move Chart dialog box will appear. Select the desired location for the chart.  

4. Click OK.  

5. The chart will appear in the selected location.  

 

Challenge! 

1. Open an existing Excel workbook.  

2. Use worksheet data to create a chart.  

3. Change the chart layout.  

4. Apply a chart style. 

5. Move the chart.  

 

9. Printing Workbooks 

There may be times when you want to print a workbook to view and share your data offline. Once you've 

chosen your page layout settings, it's easy to preview and print a workbook from Excel using the Print 

pane. 

 

To access the Print pane 

1. Select the File tab. Backstage view will appear. 

 

 

 

2. Select Print. The Print pane will appear. 
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9.1. Choosing a print area 
 

Before you print an Excel workbook, it's important to decide exactly what information you want to print. 

For example, if you have multiple worksheets in your workbook, you will need to decide if you want to 

print the entire workbook or only active worksheets. There may also be times when you want to print only 

a selection of content from your workbook. 

When you are ready to 
print the workbook, 
click the Print button. 

Here you can choose how 
many copies of the 

workbook you wish to print. 

You may need to select the printer 
you want to use if your computer is 

connected to multiple printers. 

Here you can choose to print 

the active sheets, the entire 

workbook, or a selection of 

cells. 

Here you can choose 
whether to print on one side 
or both sides of the paper. If you are printing multiple copies, 

you can choose whether you want 

the copies collated or uncollated. 

Here you can choose Portrait 

or Landscape orientation. 
If your printer uses different 

paper sizes, you can choose the 

paper size you wish to use. 

Here you can adjust the 
page margins, which can 

help your data fit more 
comfortably on the page. 

Here you can choose how to scale your 
worksheets for the printed page. You can 

scale worksheets at their actual size, fit the 
entire worksheet on one page, fit all columns 

on one page, or fit all rows on one page. 
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To print active sheets 

Worksheets are considered active when selected. 

1. Select the worksheet you want to print. To print multiple worksheets, click the first worksheet, hold 

the Ctrl key on your keyboard, then click any other worksheets you want to select.  

 

2. Navigate to the Print pane. 

3. Select Print Active Sheets from the Print Range drop-down menu.  

 

4. Click the Print button.  

 

 

 

To print the entire workbook 

1. Navigate to the Print pane. 

2. Select Print Entire Workbook from the Print Range drop-down menu.  
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3. Click the Print button.  

 

 

To print a selection 

1. Select the cells you wish to print.  

2. Navigate to the Print pane. 

3. Select Print Selection from the Print Range drop-down menu.  

 

4. A preview of your selection will appear in the Preview pane.  

5. Click the Print button to print the selection.  
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 TIP: If you prefer, you can also set the print area in advance so you'll be able to visualize which cells 

will be printed as you work in Excel. Simply select the cells you want to print, click the Page Layout 

tab, select the Print Area command, then choose Set Print Area. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9.2. Fitting and scaling content 
 

On occasion, you may need to make small adjustments from the Print pane to fit your workbook content 

neatly onto a printed page. The Print pane includes several tools to help fit and scale your content, such 

as scaling and page margins. 
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To fit content before printing 

If some of your content is being cut off by the printer, you can use scaling to fit your workbook to the page 

automatically. 

1. Navigate to the Print pane.  

2. Select the desired option from the Scaling drop-down menu. In our example, we'll select Fit Sheet 

on One Page.  

 

3. The worksheet will be condensed to fit onto a single page. 

4. When you're satisfied with the scaling, click Print.  

 

To modify margins in the Preview pane 

Sometimes you may only need to adjust a single margin to make your data fit more comfortably. You can 

modify individual page margins from the Preview pane. 

1. Navigate to the Print pane, then click the Show Margins button in the lower-right corner. 
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2. The page margins will appear in the Preview pane. Hover the mouse over one of the margin 

markers until the cursor becomes a double arrow .  

3. Click, hold, and drag the mouse to increase or decrease the margin width.  

4. Release the mouse. The margin will be modified. In our example, we were able to fit an additional 

column on the page. 

 

Challenge! 

1. Open an existing Excel workbook.  

2. Try printing two active worksheets.  

3. Try printing only a selection of cells.  

4. Try the scaling feature to condense your workbook content.  

5. Adjust the margins from the Preview pane. 

Show Margins 

button. 


